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Data Acquisition and Processing Report

NOAA Ship Ferdinand R. Hassler
Chief of Party: LCDR Marc S. Moser, NOAA

Year: 2013
Version: 1

Publish Date: 2014-01-31

A Equipment

A.1 Survey Vessels

A.1.1 NOAA Ship FERDINAND R. HASSLER

Name NOAA Ship FERDINAND R. HASSLER

Hull Number S250

Description
FERDINAND R. HASSLER is a Small Waterplane Area, Twin-Hull (SWATH)
 coastal mapping vessel.   

Utilization Survey

Dimensions

LOA 37.7 meters

Beam 18.5 meters

Max Draft 3.85 meters

Most Recent Full
Static Survey

Date 2009-11-04

Performed By
Raymond C. Impastato, Professional
Land Surveyor

Discussion

This survey was provided by the
shipbuilder, V.T. Halter Marine, and
performed in the shipyard prior to
delivery.

Most Recent Partial
Static Survey

Date 2012-06-12

Performed By Kevin Jordan, NGS

Discussion

This survey was performed after
the POS/MV antenna mounts were
reconfigured to newly fabricated
mounts and ties the POS antennae into
benchmarks on the 03 deck.
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Most Recent Full
Offset Verification

Full offset verification was not performed.

Most Recent Partial
Offset Verification

Date 2013-04-07

Method Used
Optical level run while ship was out of
the water in drydock

Discussion

A level loop was run from the POS
antenna's to each sensor mounted on the
ship hull. In addition, measurements were
made to both IMU base plates through
the 7125 cable passage. The resulting
offsets from this survey were used to
verify and update Z offsets between all
sensors.

Most Recent Static
Draft Determination

Date 2011-07-12

Method Used
Calculation from design waterline and
measured offsets

Discussion

Assumed design waterline of 3.80 meters
and measured offsets to IMU were used
to determine static draft of the reference
point. The ship's draft is operationally
managed with daily ballast to achieve
the true design waterline of 3.80 meters.
Draft uncertainty is estimated at 0.05
meters. See Section C.2.1.1 for additional
discussion.

Most Recent
Dynamic Draft
Determination

Date 2013-06-26

Method Used
Ellipsoid referenced dynamic draft
measurement (ERDDM)

Discussion
Data were acquired with canards at zero
trim angle. During all survey operations,
the canards are set to zero trim angle.
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Figure 1: NOAA Ship FERDINAND R. HASSLER, Starboard View
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Figure 2: NOAA Ship FERDINAND R. HASSLER, Bow and Stern View

A.2 Echo Sounding Equipment

A.2.1 Side Scan Sonars

A.2.1.1 Klein 5000 V2 Bathymetry

Manufacturer Klein

Model 5000 V2 Bathymetry

Description

High-speed high-resolution towed side-scan sonar (SSS) system.  This system is a beam-
forming acoustic imagery device with an operating frequency of 455 kHz and vertical beam
 width of 40°.  The Klein 5000 V2 system consists of a 5250 V2 towfish and a 5105 V2
 Transceiver Processing Unit (TPU).  The towfish is towed via 3/8" armored coaxial cable
 connected to a DT marine electro-hydraulic winch (s/n 1271 302 OEHLW3R) equipped
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 with a Klein slip ring model: (14103033, s/n 1802003).  The towfish is fitted with a Klein
 K-wing depressor wing.  The winch is controllable from the sonar operator's station. 
 Cable out is measured with a 3PS cable counter integrated with a General Oceanics model
 4042 sheave.  The sheave is mounted on the A-frame and is the tow point for offsets
 measurements.  Cable counter accuracy was verified on August 3, 2012 using a known
 length of line.

The SSS cable was re-terminated on July 27, 2012 and a new 12 meter cable mark for the
 docked and zero measurement was marked and verified on July 27, 2013. 

A side scan calibration was conducted on July 17, 2013 (Dn198) in the vicinity of Cape
 Charles City with towfish SN: 386.  

In this test a number of lines were run adjacent to a buoy block.  The side scan positions are
 compared with the multibeam positions in the attached report.  The 95% confidence interval
 of the positioning error is 7.2 meters.

In all cases during survey operation, an area well in excess of 20 meters to each side of a side
 scan contact is investigated with multibeam, therefore the positioning errors, if caused by
 current or vessel maneuvers, would not cause a feature to be improperly investigated.  No
 features are recommended for charting at SSS derived positions.  

Serial
Numbers

Vessel Installed

On
S250

TPU s/n 777

Towfish s/n 386

Specifications

Frequency 455 kilohertz

Along Track
Resolution

Resolution 10  centimeters 20  centimeters 36  centimeters 61  centimeters

Min Range 38 meters 75 meters 150 meters 250 meters

Max Range     

Across Track
Resolution

3.75 centimeters

Max Range
Scale

250 meters

Manufacturer
Calibrations

Vessel Installed

On
S250

Calibration

Date
2013-07-17
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Figure 3: Klien 5000 V2 configured for towing

A.2.2 Multibeam Echosounders

A.2.2.1 Reson 7125

Manufacturer Reson

Model 7125

Description

The Reson 7125 is a dual head, dual multibeam system configured to work as a unit. 
 While the particulars of the port system are specified in this section and the starboard
 head in the following section, this description and following quality control address
 the two heads as an integrated system. 
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The port and starboard sonars are mounted in their respective hulls with a 4.5 degree
 outboard tilt.  The sonars can be operated independently, but are typically operated
 together as a dual-head system using frequency modulated (FM) pulses combined
 with center frequency separation to enable simultaneous pinging between the heads.
  When operated as a dual head system, the starboard system acts as the master and
 the port system the slave.  The range scale, ping rate, surface sound speed, and time
 varied gain (TVG) parameters are controlled by the master.  

The 7125 receivers and projectors on both hulls were removed during the drydock
 period and reinstalled.  

400 kHz -

A patch test for the 400kHz mode was conducted on July 30, 2013 (Dn211) to
 account for newly installed POS-MV V5 inertial measurement and positioning
 devices.  The values from this test were used on all data collected post July 25, 2013
 (Dn206).

200 kHz -

A patch test for the 200kHz mode was conducted on July 31, 2013 (Dn212) in the
 vicinity of Hudson Canyon, NY. 

Serial Numbers

Vessel Installed On S250 same

Processor s/n 18210412051 same

Transceiver s/n 212036 same

Transducer s/n n/a n/a

Receiver s/n 2411045 same

Projector 1 s/n 2611093 same

Projector 2 s/n n/a n/a
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Specifications

Frequency 400 kilohertz 200 kilohertz

Along Track 1.0 degrees Along Track 2 degrees
Beamwidth

Across Track 0.5 degrees Across Track 1 degrees

Max Ping Rate 50 hertz 50 hertz

Beam Spacing
Mode

Equidistant 
Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

512
Number of
Beams

320

Max Swath Width 140 degrees 140 degrees

Depth Resolution 6 millimeters 6 millimeters

Manufacturer
Specified

150 meters 
Manufacturer
Specified

400 meters 
Depth Rating

Ship Usage 100 meters Ship Usage 250 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.
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System Accuracy
Tests

Vessel Installed On S250 S250

Methods Reference surface comparison
Ellipsoidal Referenced Lead Line
and Water Line

Results

Shallow water (15 meters) reference
surfaces were performed in the
vicinity of Cape Charles City, VA
on July 18, 2013 (Dn199). The
location of the reference surfaces
are shown in Figure 5. The 7125
400kHz sonars were operated in
dual head FM, and single head
CW. These surfaces were run with
roll compensation turned on and
their respective HVF's have been
edited to remove the roll sensor
as specified in CARIS Helpdesk
ticket #01302295. For the 400kHz
systems, the starboard head was
on average 0.03 meters deeper
with a standard deviation of 0.07.
Differences between the FM and
CW modes were within 0.02 meters
for both heads, showing good
agreement between the different
methods. The results of this test
are shown in Figures 6 through 8.
Deeper water (80 meters) reference
surfaces were performed for the
200kHz in the vicinity of Hudson
Canyon, NY on July 31, 2013
(Dn212) using data obtained during
the patch test. The location of the
reference surfaces are shown in
Figure 9. For the 200kHz systems,
the starboard head was on average
0.02 shallower with a standard
deviation of 0.27. While this
standard deviation is large, 95%
of all nodes are within +/- 0.50 in
an area with depths in excess of
1.0 meters total allowable vertical
uncertainty. The results of this test
are shown in Figures 10.

On June 14, 2013 a static lead
line comparison was performed
relative to the ellipsoid for the port
7125 system. Ellipsoid height was
obtained on a fixed mark ashore
using static GPS observations.
While the ship was pierside at
MOC-A, a lead-line was lowered to
the sea floor in the port 7125 field
of view while logging sounding
data. Observed ellipsoid height
was transferred to the suspended
lead-line using differential leveling,
and the distance from the lead to
the mark measured with a steel
survey tape. Logged sonar data
was processed through CARIS
using standard ERS methods
to yield an ellipsoid referenced
measurement. Results of this test
show the sonar measured depth
to be 0.04 meters shallower than
the lead-line derived depths with
a propagated uncertainty of 0.03
meters. In addition to the ellipsoid
measurement, the lead-line was
marked at the waterline and the
distance from the lead to the mark
measured with a steel survey tape.
Logged sonar data was processed
through Caris using a zero-tide
file to yield a waterline referenced
measurement. Sonar depths were an
average of 0.10 meters shallower
than lead-line derived depths with
a propagated error of 0.06 meters.
This result suggests there may be a
small error in the waterline offset
values, but is not conclusive. The
uncertainty of the measurement
is dominated by the uncertainty
in reading ship draft marks. This
test was repeated on July 16, 2013
for the starboard 7125 system.
Results show the sonar depth 0.06
meters shallower than the lead-line
derived depths with a propagated
uncertainty of 0.03 meters. For
the waterline; sonar measured
depths were an average of 0.01
meters shallower than the lead-line
derived depths with a propagated
error of 0.06 meters. There is still
uncertainty of the measurement,
mainly dominated by the uncertainty
in reading ship draft marks.
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Snippets Sonar has snippets logging capability.

Figure 4: 7125 Housing flush mounted on hull

Figure 5: General location of Dn178 patch test and Dn199 shallow water
reference surface in vicinity of Cape Charles, VA. Charted depths are in feet.



2013 DAPR Version 1           NOAA Ship Ferdinand R. Hassler                

11

Figure 6: Distribution of depth differences, starboard minus port for Dn151 reference surface.
Depths from starboard are on average 0.03 meters deeper than depths from port system with a

standard deviation of 0.07 meters. Sonars configured in FM simultaneous pinging configuration.
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Figure 7: Distribution of depth differences between the
starboard FM minus CW for Dn151 reference surface. 
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Figure 8: Distribution of depth differences between the port FM minus CW for Dn151 reference surface. 
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Figure 9: General location of Dn212 patch test and deeper water reference
surface in the vicinity of Hudson Canyon, NY. Charted depths are in fathoms
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Figure 10: Distribution of depth differences between the 200kHz; starboard minus port.

A.2.2.2 Reson 7125

Manufacturer Reson

Model 7125

Description
Starboard system of a dual head configuration.  For a description of this system and
 associated quality control tests, see entry for port 7125.  
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Serial Numbers

Vessel Installed On S250 same

Processor s/n 18215011048 same

Transceiver s/n 212035 same

Transducer s/n n/a n/a

Receiver s/n 85002184 same

Projector 1 s/n 1111236 same

Projector 2 s/n n/a n/a

Specifications

Frequency 400 kilohertz 200 kilohertz

Along Track 0.5 degrees Along Track 2 degrees
Beamwidth

Across Track 1 degrees Across Track 1 degrees

Max Ping Rate 50 hertz 50 hertz

Beam Spacing
Mode

Equidistant 
Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

512
Number of
Beams

320

Max Swath Width 140 degrees 140 degrees

Depth Resolution 6 millimeters 6 millimeters

Manufacturer
Specified

150 meters 
Manufacturer
Specified

400 meters 
Depth Rating

Ship Usage 100 meters Ship Usage 250 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.

System Accuracy
Tests

System accuracy test was not performed.

Snippets Sonar has snippets logging capability.

A.2.2.3 Reson 7111

Manufacturer Reson

Model 7111

Description

The Reson 7111 is a mid-water 100kHz multibeam sonar system.  The system is
 mounted in a blister fairing forward on the starboard hull.

A patch test for the 7111 was conducted on July 31, 2013 (Dn212) in the vicinity of
 Hudson Canyon, NY. 
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Serial Numbers

Vessel Installed On S250

Processor s/n 1908005

Transceiver s/n 4506285

Transducer s/n 807208

Receiver s/n 1409098

Projector 1 s/n Low

Projector 2 s/n None

Specifications

Frequency 100 kilohertz

Along Track 1.9 degrees
Beamwidth

Across Track 1.5 degrees

Max Ping Rate 20 hertz

Beam Spacing
Mode

Equidistant 

Beam Spacing
Number of
Beams

301

Max Swath Width 150 degrees

Depth Resolution 3 centimeters

Manufacturer
Specified

1000 meters 
Depth Rating

Ship Usage 500 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.

System Accuracy
Tests

Vessel Installed On S250

Methods Reference surface comparison

Results

Deeper water (80 meters) reference surfaces were performed for the
100kHz in the vicinity of Hudson Canyon, NY on July 31, 2013 (Dn212)
using data obtained during the patch test. The location of the reference
surfaces are shown in Figure 9. For the 100kHz systems, the 7111 was on
average 0.03 shallower than the starboard 200kHz system with a standard
deviation of 0.19. 95% of all nodes are within +/- 0.35 in an area with
depths in excess of 1.0 meters total allowable vertical uncertainty. The
results of this test are shown in Figures 11.

Snippets Sonar has snippets logging capability.
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Figure 11: 7111 mount and fairing. Sonar is located forward on the starboard hull.
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Figure 12: Distribution of depth differences, starboard 200kHz 7125 less 7111 for
Dn212 deep water (80 meter) reference surface. Depths from 7111 are on average 0.03

meters deeper than depths from the 7125 with a standard deviation of 0.19 meters.

A.2.3 Single Beam Echosounders

A.2.3.1 Odom CV-200

Manufacturer Odom

Model CV-200

Description
Dual-frequency digital recording echosounder system with a transducer in each hull.
 The high frequency band is tunable from 100kHz to 1 MHz. The low band is tunable
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 from 10-50 kHz. The installed Airmar M42 transducers are not broadband and the
 sonar is tuned to the operating frequency of the dual-frequency transducers installed.
  Each transducer is most efficient at 24 or 200kHz.  The system is configured with
 the low frequency signal to the port transducer and the high frequency signal to the
 starboard system to permit simultaneous, dual frequency acquisition.  The starboard
 POS system is used for positioning of the singlebeam and the starboard POS serves
 as the reference point for both transducers. 

Serial Numbers

Vessel S250

Processor s/n 3038

Transducer s/n unknown

Specifications

Frequency 200 kilohertz 24 kilohertz

Along Track 4 degrees Along Track 20 degrees
Beamwidth

Across Track 4 degrees Across Track 20 degrees

Max Ping Rate 100 hertz 100 kilohertz

Depth Resolution 0.01 meters 0.01 meters

Manufacturer

Specified
200 meters

Manufacturer

Specified
6000 meters

Depth Rating

Ship Usage 50 meters Ship Usage 700 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.
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System Accuracy
Tests

Vessel Installed On S250 S250

Methods Sounding systems comparison Reference surface comparison

Results

Sounding comparisons were
made while at anchor using the
dual-frequency vertical beam
echosounder, both port and
starboard 7125 systems and lead
line on June 26, 2013. Sea state was
calm with an estimated 1 foot chop.
This chop may have affected the
lead line measurement to report a
deeper than actual measurement.
The data from each VBES head
was averaged and compared to the
averaged data from the 7125 sonar
head on the corresponding hull. The
VBES was 0.13 meters shallower
than the lead line measurement,
0.28 meters deeper than the
Starboard 7125 measurements,
and 0.46 meters deeper than the
Port 7125 measurements. This
may be the result of acoustic
penetration into a soft sediment
bottom in the test area, which
could explain why progressively
lower frequencies produced deeper
depth measurements. Although no
sediment sample was taken in the
area, charted bottom type is sand.

Reference surfaces were performed
in the vicinity of Cape Charles City,
VA on July 18, 2013 (Dn199).
The location of the patch test is
shown in Figure 5. Results of this
comparison are inconclusive and
suggest that additional investigation
into transducer offsets and HVF
values are warranted. Currently
VBES are not planned on being
utilized for the 2013 field season.
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Figure 16: Hull mounted Odom Vertical Beam Echosounder

A.2.4 Phase Measuring Bathymetric Sonars

No phase measuring bathymetric sonars were utilized for data acquisition.

A.2.5 Other Echosounders

No additional echosounders were utilized for data acquisition.

A.3 Manual Sounding Equipment

A.3.1 Diver Depth Gauges
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No diver depth gauges were utilized for data acquisition.

A.3.2 Lead Lines

Manufacturer Unknown

Model Traditional

Description
FERDINAND R. HASSLER is equipped with two lead lines.  Lead lines are used
 for measurements near shore over submerged shoals and for echosounder depth
 comparisons. 

Serial Numbers
RA6S

7

Calibrations No calibrations were performed.

Accuracy Checks

Serial Number RA6S 7

Date 2013-06-12 2013-06-12

Procedures

The wet lead line was stretched

with an amount of force equal to

the weight, on relatively flat ground

and compared with a steel survey

tape. Values were recorded of true

measurements at lead line markings.

The wet lead line was stretched

with an amount of force equal to

the weight, on relatively flat ground

and compared with a steel survey

tape. Values were recorded of true

measurements at lead line markings.

Correctors
From the table of values obtained during the accuracy checks a table of correctors
was calculated for both lead lines. This table is stored locally aboard the
FERDINAND R. HASSLER and referenced when appropriate.

Non-Standard
Procedures

Non-standard procedures were not utilized.
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Figure 17: Leadline fitted with custom mud-shoe to limit penetration of soft bottoms. 

A.3.3 Sounding Poles

No sounding poles were utilized for data acquisition.

A.3.4 Other Manual Sounding Equipment

No additional manual sounding equipment was utilized for data acquisition.

A.4 Positioning and Attitude Equipment

A.4.1 Applanix POS/MV
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Manufacturer Applanix

Model POS/MV 320 V5

Description

Tightly coupled GPS and inertial positioning and attitude sensing system for port
 hull.  Inertial motion unit (IMU) is located below water line close to the port side
 7125 wet end.  GPS antennae are located on flying bridge of S250.  The V5 system
 was installed on July 29, 2013. 

PCS

Manufacturer Applanix

Model POS/MV 320 V5

Description Rack mounted POS control system located in charting lab.

Firmware Version 7.61

Software Version 7.60

Serial Numbers

Vessel Installed

On
S250 Port

PCS s/n 5806

IMU

Manufacturer Applanix

Model Type 36

Description

Inertial measurement system consisting of three orthogonal

accelerometers and three orthogonal fiber-optic gyroscopes. Located in

port hull near 7125 wet end.

Serial Numbers

Vessel Installed

On
S250 Port hull

IMU s/n 2423

Certification
IMU s/n 2423

Certification Date 2013-06-26
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Antennas

Manufacturer Trimble

Model 382AP GNSS

Description

GNSS antennae are used for position input as well as aiding the heading

solution. The antennae pair for the port system is the forward and aft

pair on the port side. The separation distance between the antennae is

approximately 2 meters.

Serial Numbers

Vessel Installed

On
S250 Port (forward) S250 Port (aft)

Antenna s/n 8848 8839

Port or

Starboard
Port Port

Primary or

Secondary
Primary Secondary

GAMS Calibration
Vessel S250

Calibration Date 2013-07-30

Configuration
Reports

POS/MV configuration reports were not produced.

Manufacturer Applanix

Model POS/MV 320 V5

Description

Tightly coupled GPS and inertial positioning and attitude sensing system for port
 hull.  Inertial motion unit (IMU) is located below water line close to the port side
 7125 wet end.  GPS antennae are located on flying bridge of S250.   The V5 system
 was installed on July 29, 2013. 

PCS

Manufacturer Applanix

Model POS/MV 320 V5

Description Rack mounted POS control system located in charting lab.

Firmware Version 7.61

Software Version 7.60

Serial Numbers

Vessel Installed

On
S250 Starboard

PCS s/n 5807
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IMU

Manufacturer Applanix

Model Type 36

Description

Inertial measurement system consisting of three orthogonal

accelerometers and three orthogonal fiber-optic gyroscopes. Located in

starboard hull near 7125 wet end.

Serial Numbers

Vessel Installed

On
S250 Starboard hull

IMU s/n 2424

Certification
IMU s/n 2424

Certification Date 2013-06-26

Antennas

Manufacturer Trimble

Model 382AP GNSS

Description

GNSS antennae are used for position input as well as aiding the heading

solution. The antennae pair for the starboard system is the forward and aft

pair on the starboard side. The separation distance between the antennae is

approximately 2 meters.

Serial Numbers

Vessel Installed

On
S250 Starboard (forward) S250 Starboard (aft)

Antenna s/n 8840 8838

Port or

Starboard
Starboard Starboard

Primary or

Secondary
Primary Secondary

GAMS Calibration
Vessel S250

Calibration Date 2013-07-26

Configuration
Reports

POS/MV configuration reports were not produced.

A.4.2 DGPS
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Description Hemisphere PGS MBX Kit 

Antennas

Manufacturer Hemisphere

Model MBX-4

Description

Serial Numbers
Vessel Installed On S250

Antenna s/n 1113139440044

Receivers

Manufacturer Hemisphere

Model MBX-4

Description

Firmware Version 1.0

Serial Numbers
Vessel Installed On S250

Antenna s/n 1118144550001

A.4.3 Trimble Backpacks

Trimble backpack equipment was not utilized for data acquisition.

A.4.4 Laser Rangefinders

No laser rangefinders were utilized for data acquisition.

A.4.5 Other Positioning and Attitude Equipment

No additional positioning and attitude equipment was utilized for data acquisition.

A.5 Sound Speed Equipment

A.5.1 Sound Speed Profiles

A.5.1.1 CTD Profilers
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A.5.1.1.1 Sea-Bird SeaCat 19plus 350 meter and 3500 meter

Manufacturer Sea-Bird

Model SeaCat 19plus 350 meter and 3500 meter

Description Internal logging conductivity, temperature, and depth measuring devices. 

Serial Numbers
Vessel Installed On S250 S250 S250

CTD s/n 19P65591-6918 19P32914-4480 19P36399-4642

Calibrations

CTD s/n 6918 4480 4642

Date 2013-02-21 2013-02-21 2013-02-21

Procedures
Routine calibration

service

Routine calibration

service

Routine calibration

service
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Figure 18: Ferdinand R. Hassler CTD inventory
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A.5.1.2 Sound Speed Profilers

A.5.1.2.1 Brooke Ocean MVP-30

Manufacturer Brooke Ocean

Model MVP-30

Description

Moving vessel profiler equipped with an AML Micro-CTD in a single sensor free fall
 fish:
The MVP cable was end-for-ended and re-terminated on September 3, 2013.  A new
 towfish was equipped with an AML Micro-CTD on September 27th, 2013, and
 verified to be in working order by sound speed comparison cast. 

Serial Numbers
Vessel Installed On S250 S250

Sound Speed Profiler s/n 8609 8610

Calibrations

Sound Speed Profiler s/n 8609 8610

Date 2013-05-09 2013-05-09

Procedures Initial calibration for new sensor Initial calibration for new sensor
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Figure 19: MVP control station & winch
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Figure 20: MVP single sensor free fall fish. 

A.5.2 Surface Sound Speed

A.5.2.1 Sea-Bird 45 MicroTSG

Manufacturer Sea-Bird
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Model 45 MicroTSG

Description

Two SBE-45 thermosalinographs are installed to determine the sound velocity
 of the water at the sonar transducers.  This data is used to aid beam steering of
 the multibeam 7111 sonar system.  One is located in the starboard engine room,
 the other in the port.  Both units draw sampling water from the main cooling
 water line of the respective main engine.  The SBE-45s are configured to use their
 internal temperature sensors.  Both units are insulated with foam to ensure accurate
 temperature readings.  These devices calculate the sound speed from the measured
 salinity and temperature (using the Chen-Millero equation) of the sampled water.
  A serial broadcast device sends the sound speed message from the SBE-45 to the
 Reson 7111 and SCS acquisition server. 

Serial Numbers
Vessel Installed On S250 Port S250 Starboard

Sound Speed Sensor s/n 4553332-0276 4553332-0277

Calibrations

Sound Speed Sensor s/n 4553332-0276 4553332-0277

Date 2013-02-28 2013-02-28

Procedures Routine calibration service Routine calibration service

A.5.2.2 Reson SVP-70

Manufacturer Reson

Model SVP-70

Description

Sound velocity probe developed for fixed-mount installation near Reson 7125
 transducer heads which uses a direct path echosounding technique that instantly
 compensates for temperature and pressure with internal sensors, providing accurate
 surface sound velocity measurements for beam steering. 

Serial Numbers
Vessel Installed On S250 Port hull S250 Starboard hull

Sound Speed Sensor s/n 2011278 2011276

Calibrations

Sound Speed Sensor s/n 2011278 2011276

Date 2011-09-21 2011-09-21

Procedures

Manufacturer performed

temperature and pressure

calibrations and validation prior

to delivery. A Hart 1504 and

thermistor was used for temperature

and a custom-built tank was used for

the pressure calibration.

Manufacturer performed

temperature and pressure

calibrations and validation prior

to delivery. A Hart 1504 and

thermistor was used for temperature

and a custom-built tank was used for

the pressure calibration.

Additional Discussion
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When in the deployed and docked position, the MVP sensor is towed at approximately the same height as
 the surface sound speed sensor.  As part of the system start up and watch turnover procedures as well as
 periodically through a survey watch, these values are verified to be in agreement.  In addition, comparison
 casts between a SeaCat 19+ and the MVP are conducted once a leg or if any issues with the MVP sensor are
 suspected.  The results of these tests are included in the Separates section of each survey. 

A.6 Horizontal and Vertical Control Equipment

A.6.1 Horizontal Control Equipment

A.6.1.1 Base Station Equipment

Description Trimble NetR5 receiver used for long-term GPS base observations and correctors. 

GPS Antennas

Manufacturer Trimble

Model Zephyr Geodetic Model 2

Description

The Zephyr Geodetic 2 is the antenna component for the NetR5 system
which incorporates a large Trimble Stealth™ Ground Plane, which burns
up multipath energy using technology similar to that used by Stealth
aircraft to hide from radar. The antenna is made with weather-resistant
materials and a low profile design, so the antenna can be used for many
years of continuous operation on a permanent installation.

 

Serial Numbers 1440921338

GPS Receivers

Manufacturer Trimble

Model NetR5 GNSS

Description

The Trimble NetR5 Reference Station is a multi-channel, multi-frequency
GNSS receiver designed for use as a stand-alone reference station or as
part of a GNSS infrastructure solution.

 

Firmware Version 4.03

Serial Numbers 4934K63376

UHF Antennas No UHF antennas were installed.

UHF Radios No UHF antennas were installed.

Solar Panels No solar panels were installed.
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Solar Chargers No solar chargers were installed.

DQA Tests No DQA tests were performed.

A.6.1.2 Rover Equipment

No rover equipment was utilized for data acquisition.

A.6.2 Vertical Control Equipment

No vertical control equipment was utilized for data acquisition.

A.7 Computer Hardware and Software

A.7.1 Computer Hardware

Manufacturer Dell

Model T5500

Description Processing Computers 

Serial Numbers

Computer s/n
FH-PROC1
Service Tag #
GFTQ8V1

FH-PROC2
Service Tag #
GFTR8V1

FH-PROC3
Service Tag #
GFTN8V1

FH-PROC4
Service Tag #
GFTM8V1

Operating System Windows 7 Windows 7 Windows 7 Windows 7

Use Processing Processing Processing Processing

Manufacturer Dell
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Model T3400

Description Acquisition Computers  

Serial Numbers

Computer s/n
FH-ACQ1 Service Tag
# 101WTK1

FH-ACQ2 Service Tag
# 201WTK1

FH-ACQ3 Service Tag
# 6P5VTK1

Operating System Windows XP Windows XP Windows XP

Use Acquisition Acquisition Acquisition

Manufacturer Cybertron PC

Model Generic

Description Processing Computer 

Serial Numbers

Computer s/n FH-PROC5 Service Tag # FQC-00765

Operating System Windows 7

Use Processing

A.7.2 Computer Software

Manufacturer CARIS

Software Name HIPS/SIPS

Version 7.1

Service Pack 2

Hotfix 5

Installation Date 2013-04-02

Use Processing

Description Data Processing

Manufacturer CARIS

Software Name Bathy DataBASE Editor

Version 4.0

Service Pack 0

Hotfix 0

Installation Date 2013-04-02

Use Processing

Description Data analysis and feature management

Manufacturer CARIS
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Software Name Plot Composer

Version 5.2

Service Pack

Hotfix

Installation Date 2013-04-02

Use Processing

Description Mapping and plotting software

Manufacturer Applanix

Software Name POSPac

Version 6.1

Service Pack

Hotfix

Installation Date 2013-04-02

Use Processing

Description Position and Attitude processing software

Manufacturer NOAA

Software Name Pydro

Version 13.2

Service Pack r4326

Hotfix

Installation Date 2013-09-28

Use Processing

Description Feature management, correlation, and report generator

Manufacturer NOAA

Software Name Pydro

Version 13.8

Service Pack r4429

Hotfix

Installation Date 2014-01-06

Use Acquisition

Description
Feature management, correlation, and report generator (further updated versions that
occur during processing will be discussed in the descriptive report)
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Manufacturer NOAA

Software Name Velocipy

Version 12.9

Service Pack r3952

Hotfix

Installation Date 2013-04-02

Use Acquisition and Processing

Description Sound velocity download and processing software

Manufacturer NOAA

Software Name Velocipy

Version 13.2

Service Pack r4326

Hotfix

Installation Date 2013-09-28

Use Acquisition and Processing

Description Sound velocity download and processing software

Manufacturer NOAA

Software Name Velocipy

Version 13.8

Service Pack r4429

Hotfix

Installation Date 2014-01-06

Use Acquisition and Processing

Description
Sound velocity download and processing software (further updated versions that
occur during processing will be discussed in the descriptive report)

Manufacturer Pitney Bowes

Software Name MapInfo

Version 11.5

Service Pack

Hotfix

Installation Date 2013-04-02

Use Acquisition and Processing
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Description GIS software

Manufacturer IVS 3D

Software Name Fledermaus

Version 7

Service Pack 3

Hotfix 4

Installation Date 2013-07-02

Use Processing

Description Data modeling

Manufacturer Hypack

Software Name Hypack/Hysweep

Version 2013

Service Pack

Hotfix

Installation Date 2013-04-02

Use Acquisition

Description Data logging

Manufacturer Klein

Software Name SonarPro

Version 12.1

Service Pack

Hotfix

Installation Date 2012-05-11

Use Acquisition

Description Side Scan control

Manufacturer Applanix

Software Name POSView

Version 7.0

Service Pack

Hotfix

Installation Date 2013-07-26
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Use Acquisition

Description Positioning

Manufacturer Synergy

Software Name Synergy

Version 1.3.6

Service Pack

Hotfix

Installation Date 2011-05-10

Use Acquisition

Description Shared mouse and keyboard between acquisition systems

A.8 Bottom Sampling Equipment

A.8.1 Bottom Samplers

A.8.1.1 Ponar Wildco 1728

Manufacturer Ponar Wildco

Model 1728

Description Grab sampler triggered by contact with sea floor. 
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Figure 21: Ponar Grab Sampler
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B Quality Control

B.1 Data Acquisition

B.1.1 Bathymetry

B.1.1.1 Multibeam Echosounder

Multibeam data are logged locally on the Reson topside machines in s7k format.  Multibeam data are also
 acquired through Hypack/Hyweep in HSX format for bathymetry, though these files are only used in the
 event of errors in the s7k file and are otherwise discarded.  The HSX format includes sounding solutions,
 navigation and attitude data.  Ship navigation and survey line monitoring are performed with Hypack/
Hysweep.  The s7k format includes sounding solutions, navigation, attitude and backscatter snippet data.
  This record is configured to include the following Reson datagrams: 1003: Position; 1012: Roll, Pitch,
 Heave; 1013: Heading; 7000: 7k Sonar Settings; 7004: 7k Beam Geometry; 7006: 7k Bathymetric Data;
 7008: 7k Generic Watercolumn Data (used for snippets backscatter) and 7503: Remote Control Sonar
 Settings.  

All multibeam sonars are configured in equidistant ("Best Coverage" in newest Reson version) beam steering
 mode.  The opening angle of the 7125 systems is configured based on analysis of coverage, speed, and
 expected sound speed refraction errors for each survey.  This angle typically varies between 120 and 140
 degrees.  Power, gain, and TVG parameters are typically set for a particular project and not changed during
 acquisition. 

The Reson units are interfaced with the acquisition machines through UDP LAN connections over a
 dedicated network switch (NetGear ProSafe Gigabit Switch).  Position and attitude data is passed from the
 POS-MV to both the Reson machines and to the acquisition computers through dedicated network switches
 (NetGear ProSafe Gigabit Switch).  There is a dedicated switch for the port and starboard POS systems.
  Time is passed from the POS to the Reson machines via a RS232 serial connection and a PPS pulse via
 a coaxial cable with BNC connectors.  The starboard POS is interfaced with the starboard 7125 and the
 7111, which is located in the starboard hull.  The port POS is interfaced to the port 7125.  A diagram of this
 configuration is included with the support files to this report and illustrated in Figure 22. 
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Figure 22: Ship survey systems wiring diagram

B.1.1.2 Single Beam Echosounder

Single beam echosounder bathymetry was not acquired.

B.1.1.3 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not acquired.

B.1.2 Imagery

B.1.2.1 Side Scan Sonar

The side scan fish is towed from a block suspended from the A-frame on the stern of the vessel.  The height
 of the fish above the sea floor is actively managed through use of the remote winch control.  Side scan
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 imagery is monitored and logged using SonarPro.  Tow cable offset values are entered into SonarPro to
 account for cable out in the docked tow position.  This position has 12 meters of cable between the tow
 point and the fish.

Survey lines are pre-planned to achieve coverage required by the project instructions.  These lines are
 planned in MapInfo and exported to Hypack.  Hypack is used for ship navigation and for survey line
 tracking.

B.1.2.2 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not acquired.

B.1.3 Sound Speed

B.1.3.1 Sound Speed Profiles

Seabird SBE 19plus and MVP sound speed profilers are used regularly to collect sound speed data for ray
 tracing corrections for the multibeam sonar systems.  In shallow water, the SBE 19plus is hand deployed
 from the stern.  In deeper water the MVP winch is used.  Data is retrieved from the Seabird CTDs with a
 serial connection to a processing computer.  Data from both the Seabirds and MVP are processed through
 the NOAA in-house program Velocipy to give CARIS .svp formatted sound velocity profiles.  All .svp
 profiles for a survey sheet are concatenated to one master file for a survey.

Casts are taken at least every four hours, but typically far more frequently.  The interval between casts
 is typically between ten minutes and three hours based on the observed variability between casts and is
 discussed in the Descriptive Report of each survey.
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Figure 23: Example of sound speed samples taken in a survey area

B.1.3.2 Surface Sound Speed

Surface sound speed for both Reson 7125's is fed from individual SVP-70 sound velocity sensors mounted
 near each transducer.  While operating in dual-head mode the starboard SVP-70 feeds both the master
 and slave.  Seabird TSG 45 thermosalinograph is used for determination of sea surface conductivity and
 temperature and calculate surface sound speed for the Reson 7111.  

During data acquisition, the port SVP-70 sensor began reporting sound speeds of 1350 m/s (the default
 value used by Reson).  Additionally, the starboard SVP-70 was determined to be reporting incorrect sound
 speed values.  A comparison was performed on Dn307 between the starboard SVP-70, TSG, MVP, and
 CTD sensors determined the magnitude of the error reported by the starboard SVP-70 to be 5 m/s from the
 estimated corrected value (Figure 24).  The port TSG sensor was configured to be the source of surface
 sound speed data for both Reson 7125's on Dn319.
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Figure 24: Results of Surface Sound Speed comparison to determine SVP-70 measurement error.

B.1.4 Horizontal and Vertical Control

B.1.4.1 Horizontal Control

Applanix POS/MV files are logged using both the internal (USB) logging function and using the external
 Ethernet logging function.  Both files contain the same data records including attitude, heading, position
 and velocity data as stated in section 3.4.1 of the FPM.  During acquisition, the navigation solution status is
 constantly monitored by the acquisition watch stander.

The internal (USB) logged files are size limited, therefore files submitted typically start with the .000
 extension and increment upwards (e.g. .001, .002, .003, ...).  There are approximately 240 files generated
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 during 24 hours of acquisition.  The Ethernet logged files are typically broken at approximately UTC noon
 each day to yield two files per hull for a survey day.  

Real-time USCG DGPS correctors are used for all acquisition.  Specific DGPS stations are noted in the DR
 accompanying each survey.

B.1.4.2 Vertical Control

Preliminary, observed and verified water levels are downloaded using FetchTides and applied to the data
 using CARIS HIPS Load Tide function.  For data submission, depth data are reduced to MLLW either
 through application of Verified Water levels and Verified Tidal Zoning or using GPS derived vertical
 positions and the VDatum model.  Refer to individual sheet DRs for detailed methods and additional
 information.

B.1.5 Feature Verification

Feature verification followed guidelines set forth in section 3.5.5 of the FPM.  Refer to individual sheet DRs
 for additional information.

B.1.6 Bottom Sampling

Bottom Sampling followed guidelines set forth in sections 7.1 of the HSSD and 2.5.4.2.1 of the FPM. 
 Bottom sample locations are guided by analysis of the backscatter and bathymetry of the survey area  Refer
 to individual sheet DRs for additional information.

B.1.7 Backscatter

Backscatter is acquired in the 7008 record logged in the .s7k files directly from the Reson 7125 processors.
  For the 7125 400kHz systems, snippet size is set to 25 samples in water depths less than 50 meters and to
 50 samples in depth greater than 50 meters.  The 7125 200kHz system has snippets size set to 100 in depths
 less than 100 meters and 200 in all depths greater than 100 meters.  7111 snippet size is set to 40 samples in
 depths less than 80 meters, 80 samples in depths between 150 and 300 meters, and 120 samples in deeper
 depths.  All processing of backscatter is done using the FMGT module of the QPS Fledermaus package. 
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B.1.8 Other

No additional data were acquired.

Additional Discussion

FERDINAND R. HASSLER maintains a continuous manned survey watch during all survey acquisition.
 The watch stander is in constant communication with the bridge and monitors the performance of all
 systems.  Thresholds set in Hypack/Hysweep, POSview, Reson and SonarPro alert the watch stander by
 displaying alarm messages when error thresholds or tolerances are exceeded. Alarm conditions that may
 compromise survey data quality are corrected and then noted in acquisition log. Warning messages such
 as the temporary loss of differential GPS, excessive cross track error, or vessel speed approaching the
 maximum allowable survey speed are addressed by the watch stander and corrected before further data
 acquisition occurs.

B.2 Data Processing

B.2.1 Bathymetry

B.2.1.1 Multibeam Echosounder

Bathymetry processing follows section 4.2 of the FPM unless otherwise noted.

Raw .s7k multibeam data are converted to CARIS HIPS HDCS format using established and internally
 documented settings.  After TrueHeave, sound speed and water level correctors are applied to all lines, the
 lines are merged.  Once lines are merged, Total Propagated Uncertainty (TPU) is computed using settings
 documented for each survey in the Descriptive Report.  Default CARIS device models (C:\CARIS\HIPS
\71\System\devicemodels.xml) are used during processing.

The general resolution, depth ranges, and Combined Uncertainty and Bathymetric Estimator (CUBE)
 parameter settings outlined in section 5.2.2.2 of the HSSD and section 4.2.1.1.1.1 of the FPM are used for
 surface creation and analysis.  If these depth range values for specific resolutions require adjustment for
 analysis and submission of individual surveys then the required waiver from HSD Operations is requested.
  A detailed listing of the resolutions and the actual depth ranges used during the processing of each survey,
 along with the corresponding fieldsheet(s), is provided in the Descriptive Report of each survey.

BASE surfaces are created using the CUBE algorithm and parameters contained in the NOAA
 CUBEParams_NOAA.xml file as provided in Appendix 4 of the FPM.  The CUBEParams_NOAA.xml
 file is included with the HIPS Vessel Files with the individual survey data.  The NOAA parameter
 configurations for resolutions 0.5-16 meters are used.
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Multibeam data are reviewed and edited in HIPS Subset Editor as necessary.  The finalized BASE surfaces
 and CUBE hypotheses guide directed data editing at the appropriate depth range in subset editor.  The
 surfaces and subset editor view are also used to demonstrate coverage and to check for errors due to tides,
 sound speed, attitude and timing.

Vessel heading, attitude, and navigation data are reviewed in HIPS navigation editor and attitude editor
 if deemed necessary upon review of surfaces.  Where necessary, fliers or gaps in heading, attitude, or
 navigation data are manually rejected or interpolated for small periods of time.  Any editing of this nature
 will be outlined in the Descriptive Report for the particular survey.

Either the Density or the Density & Locale method for hypothesis disambiguation is typically used.  This
 follows section 4.2.1.1.1 of the FPM as available disambiguation methods.  The disambiguation method can
 be seen in each individual layers properties and can be modified if desired.

The surface filtering function in CARIS HIPS is not utilized routinely.  If utilized, the individual Descriptive
 Report lists the confidence level settings for standard deviation used and discuss the particular way the
 surface filter was applied.

Designated soundings are selected as outlined in section 5.2.1.2 of the HSSD.

IHO child layers are created using the following two formulas for IHO_1 and IHO_2, respectively; -
Uncertainty/((0.5^2 +((Depth*0.013)^2))^0.5) and -Uncertainty/((1.0^2 +((Depth*0.023)^2))^0.5).  IHO_1
 is created for all soundings less than 100 meters while IHO_2 is for 100 meters and deeper.  This layer
 is then exported and run through an application which computes statistics.  The results are reported and
 analyzed in each sheets' individual DR, but the layers are not submitted with the survey. 

Additionally, a combined surface is reviewed in 3-D mode using one of the following programs; CARIS
 HIPS, CARIS Base Editor or IVS Fledermaus, to ensure that the data are sufficiently free of artifacts and is
 a reasonable model of the sea floor. 
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Figure 25: MBES flow diagram

B.2.1.2 Single Beam Echosounder

ODOM single beam data are converted to CARIS HIPS HDCS format using the Hypack .RAW file and
 internally documented settings.  The .BIN file is copied along with the .RAW file to allow for the manual
 adjustment of fliers rather than rejecting completely.  
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Figure 26: VBES flow diagram

B.2.1.3 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not processed.

B.2.1.4 Specific Data Processing Methods

B.2.1.4.1 Methods Used to Maintain Data Integrity

Processing logs are used to record and communicate problems from acquisition to final processing.

B.2.1.4.2 Methods Used to Generate Bathymetric Grids

All methods used to generate final bathymetric grids are followed as put forth in section 4.2 and all relevant
 subsections of the FPM.

B.2.1.4.3 Methods Used to Derive Final Depths
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Methods Used

Cleaning Filters

Gridding Parameters

Surface Computation Algorithms

Description
Filters are used on a case by case basis as determined by the hydrographer, refer to
individual sheet DRs for more information.

B.2.2 Imagery

B.2.2.1 Side Scan Sonar

Side scan sonar data are converted from .sdf (SonarPro raw format) to CARIS HDCS lines.  Fish height,
 vessel heading, and vessel navigation records are reviewed for each file and edited as necessary.  Tow point
 offsets (A-Frame and cable out), fish depth, fish attitude, and water depth are used to calculate horizontal
 layback.  Towfish navigation is recalculated using CARIS SIPS.

After towfish navigation is recalculated, side scan imagery data are slant-range corrected and examined
 for targets.  Targets are selected and saved as contacts to a contact file for each line of SSS data.  Contact
 selections includes measuring apparent height and width, selecting contact position, and creating a contact
 snapshot image.  Targets are exported to CARIS BASE Editor for correlation and processing.  Significant
 targets (as defined in Section 6.3.2 of the Specifications and Deliverables) are correlated with MBES to
 obtain least depths.  All side scan lines are check-scanned by a qualified hydrographer, i.e. all SSS imagery
 is examined by at least two independent hydrographers.

Figure 27: SSS flow diagram
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B.2.2.2 Phase Measuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not processed.

B.2.2.3 Specific Data Processing Methods

B.2.2.3.1 Methods Used to Maintain Data Integrity

Processing logs are used to record and communicate problems from acquisition to final processing.

B.2.2.3.2 Methods Used to Achieve Object Detection and Accuracy Requirements

Range of the SSS, XTE, speed of vessel collecting data and repetitious processing examinations are all used
 to ensure that object detection and accuracy requirements are met.

B.2.2.3.3 Methods Used to Verify Swath Coverage

Swath coverage is verified through construction of side scan mosaics.  During acquisition, the outer portions
 of the swath are monitored for refraction artifacts.  If an apparent refraction artifact impacts objects
 detection ability and cannot be eliminated through adjustment of fish height, the range scale is reduced.

B.2.2.3.4 Criteria Used for Contact Selection

In CARIS SIPS, if an apparent shadow measures greater than 1.0 meters a contact is chosen for development
 by MBES.

B.2.2.3.5 Compression Methods Used for Reviewing Imagery

No compression methods were used for reviewing imagery.

B.2.3 Sound Speed

B.2.3.1 Sound Speed Profiles

Daily sound speed profiles from the SBE and MVP profilers are processed with Velocipy after acquisition.

B.2.3.1.1 Specific Data Processing Methods

B.2.3.1.1.1 Caris SVP File Concatenation Methods
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CTD profiles from the Seabird SBE 19-plus and AML Micro-CTD are processed using the NOAA
 developed program Velocipy. From each system, sound speed profiles are extracted and archived as both
 individual and concatenated CARIS SVP files.

Figure 99: no figure

B.2.3.2 Surface Sound Speed

The SBE-45s are configured to average four samples and report the result once a second.  No additional
 filters are applied. 

Figure 99:  no figure

B.2.4 Horizontal and Vertical Control

B.2.4.1 Horizontal Control

Fixed USCG DGPS stations are used for all real time horizontal control. If post-processed GPS techniques
 are used to improve horizontal and vertical control, specific information is included in the Descriptive
 Report and/or the project's Horizontal and Vertical Control Report.

If USB logged TrueHeave files contain IMU data gaps or other errors apparent during post processing then
 Ethernet logged files may be examined and used if free from gaps.  If this is the case both files will be
 submitted with the GNSS data.

Figure 99: no figure
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B.2.4.2 Vertical Control

CO-OPS zoned water levels utilizing water level observations from fixed, continuously operating NOAA
 tide gages are used for reduction of data to MLLW. Predicted water levels are applied during preliminary
 processing. Before submission, verified water levels are applied to all tidally corrected data. If post
 processed GPS techniques are used to improve vertical control, specific information is included in the
 Descriptive Report and/or the project's Horizontal and Vertical Control Report.

Figure 99: no figure

B.2.5 Feature Verification

Features are processed using CARIS Bathy DataBase software and are included with submitted processed
 data in the survey's final feature file (FFF) in S-57 .000 format.  The FFF includes all features; buoys, rocks,
 wrecks, bottom samples, etc., addressed within the limits of each individual sheet.

Figure 99: no figure

B.2.6 Backscatter

All backscatter was processed from acquired Reson .s7k or Hypack .HSX files. All backscatter processing
 is performed with QPS Fledermaus Geocoder Toolbox and a mosaic calculated with default processing
 parameters. Reson TVG plugins are used for all processing steps.

Figure 99: no figure
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B.2.7 Other

No additional data were processed.

B.3 Quality Management

Standard operating procedures (SOPs) and checklists are followed by personnel throughout the survey to
 ensure consistent high quality data and products.

Data is reviewed for artifacts and errors during daily processing and is reviewed by the Operations Officer
 and/or Hydrographic Senior Survey Technician daily.  Before any data is to be submitted it is reviewed
 independently by at least three experienced hydrographers who are signatories to the Descriptive Report.

B.4 Uncertainty and Error Management

TPU is processed using the following settings.

B.4.1 Total Propagated Uncertainty (TPU)

B.4.1.1 TPU Calculation Methods

TPU is calculated in CARIS HIPS using the Compute TPU tool.  Project specific values for tide and sound
 speed are entered and used over the duration of each project.  

B.4.1.2 Source of TPU Values

Error values for the multibeam and positioning systems were compiled from manufacturer specifications
 sheets for each sensor and from values set forth in section 4.2.3.8 of the 2013 FPM.

B.4.1.3 TPU Values

Vessel S250 (Port)

Echosounder Reson 7125 200 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees
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Navigation
Position

0.500 meters

Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.050 meters

y 0.050 meters

z 0.050 meters

MRU Alignment

Gyro 0.100 degrees

Pitch 0.020 degrees

Roll 0.020 degrees

Vessel

Speed 0.050 meters/second

Loading 0.050 meters

Draft 0.050 meters

Delta Draft 0.050 meters

Vessel S250 (Port)

Echosounder Reson 7125 400 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5.000 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees

Navigation
Position

0.500 meters

Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.050 meters

y 0.050 meters

z 0.050 meters
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MRU Alignment

Gyro 0.060 degrees

Pitch 0.020 degrees

Roll 0.020 degrees

Vessel

Speed 0.050 meters/second

Loading 0.050 meters

Draft 0.050 meters

Delta Draft 0.050 meters

Vessel S250 (Starboard)

Echosounder Reson 7111 100 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5.000 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees

Navigation
Position

1.000 meters

Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.100 meters

y 0.100 meters

z 0.100 meters

MRU Alignment

Gyro 0.130 degrees

Pitch 0.030 degrees

Roll 0.030 degrees

Vessel

Speed 0.030 meters/second

Loading 0.040 meters

Draft 0.050 meters

Delta Draft 0.050 meters

Vessel S250 (Starboard)

Echosounder Reson 7125 200 kilohertz
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TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 degrees

Navigation
Position

1.000 meters

Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.050 meters

y 0.050 meters

z 0.050 meters

MRU Alignment

Gyro 0.080 degrees

Pitch 0.010 degrees

Roll 0.010 degrees

Vessel

Speed 0.050 meters/second

Loading 0.050 meters

Draft 0.050 meters

Delta Draft 0.050 meters

Vessel S250 (Starboard)

Echosounder Reson 7125 400 kilohertz

TPU Standard
Deviation Values

Motion

Gyro 0.020 degrees

Heave
5 % Amplitude

0.050 meters

Pitch 0.020 degrees

Roll 0.020 radians

Navigation
Position

1.000 meters
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Timing

Transducer 0.005 seconds

Navigation 0.005 seconds

Gyro 0.005 seconds

Heave 0.005 seconds

Pitch 0.005 seconds

Roll 0.005 seconds

Offsets

x 0.050 meters

y 0.050 meters

z 0.050 meters

MRU Alignment

Gyro 0.050 degrees

Pitch 0.020 degrees

Roll 0.020 degrees

Vessel

Speed 0.050 meters/second

Loading 0.050 meters

Draft 0.050 meters

Delta Draft 0.050 meters

B.4.2 Deviations

There were no deviations from the requirement to compute total propagated uncertainty.

Additional Discussion

During the 2012 field season, the method of calculating the MRU alignment uncertainty was revised.  The
 previous method estimated the alignment uncertainty by taking the standard deviation of each evaluators'
 best estimate.  This method was modified to have each evaluator make five measurements of each offset
 (e.g. roll).  The average of all these values was taken as the patch test value, the standard deviation of the
 mean (standard deviation of all the independent measurements divided by the square root of the number
 of measurements) was used as at the MRU alignment error.  This better models the expected error in the
 estimate of the true offset value rather than the uncertainty of any particular evaluator's estimate.  This new
 method was utilized for calculating the MRU alignment uncertainty for the 2013 field season.

For the port 7125, the MRU gyro alignment uncertainty value is 0.06 degrees with the new method compared
 with 0.29 degrees with the previous method.  The Roll/ Pitch MRU alignment uncertainty is 0.02 degrees
 with the new method compared to 0.13 degrees with the previous method.  

For the starboard 7125, the MRU gyro alignment uncertainty value is 0.05 degrees with the new method
 compared with 0.22 degrees with the previous method.  The Roll/ Pitch MRU alignment uncertainty is 0.02
 degrees with the new method compared to 0.11 degrees with the previous method.
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C Corrections To Echo Soundings

C.1 Vessel Offsets and Layback

C.1.1 Vessel Offsets

C.1.1.1 Description of Correctors

C.1.1.2 Methods and Procedures

Sensor offsets are measured with respect to the vessel's reference point.  These offsets are derived from the
 full survey performed in the shipyard, a partial survey performed by NGS personnel and measurements/
verifications performed by FERDINAND R. HASSLER personnel.  All offsets are tracked and updated as
 needed on a spreadsheet submitted with the appendices of this report.  

The port IMU serves as the reference point for the port-only 7125 HSX configuration, the port 7125 s7k
 configuration and the side scan sonar. For all other vessel configurations the starboard IMU is the reference
 point.

POS GPS antennae pairs are mounted to a 2 meter length of channel extrusion in a fore and aft orientation.

C.1.1.3 Vessel Offset Correctors

Vessel S250 Port

Echosounder
Reson 7125 - After installation of POS-MV V5 (July 25, 2013) this is not a dual head
system. 400 kilohertz

Date 2013-07-01

Offsets MRU to Transducer

x -1.244 meters

y 0.362 meters

z 1.381 meters

x2 -1.244 meters

y2 0.362 meters

z2 1.349 meters
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Nav to Transducer

x -2.246 meters

y -2.351 meters

z 14.250 meters

x2 -2.246 meters

y2 -2.351 meters

z2 14.269 meters

Transducer Roll
Roll 4.500 degrees

Roll2 4.500 degrees

Vessel S250 Starboard

Echosounder
Reson 7125 - After installation of POS-MV V5 (July 25, 2013) this is not a dual head
system. 400 kilohertz

Date 2013-07-01

Offsets

MRU to Transducer

x 1.424 meters

y 0.380 meters

z 1.390 meters

x2 1.424 meters

y2 0.380 meters

z2 1.358 meters

Nav to Transducer

x 4.528 meters

y -2.320 meters

z 14.259 meters

x2 4.528 meters

y2 -2.320 meters

z2 14.278 meters

Transducer Roll
Roll -4.500 degrees

Roll2 -4.500 degrees

Vessel S250

Echosounder Reson 7111 100 kilohertz

Date 2013-07-01

Offsets MRU to Transducer

x 1.203 meters

y 11.608 meters

z 0.977 meters

x2  

y2  

z2  
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Nav to Transducer

x 4.307 meters

y 8.908 meters

z 13.897 meters

x2  

y2  

z2  

Transducer Roll
Roll 0.000 degrees

Roll2 0.000 degrees

Vessel S250

Echosounder
Odom Echotrac CV200 - Transducer 1 = Starboard hull (200 kHz), Transducer 2 =
Port hull (24 kHz) 24 kilohertz

Date 2013-07-01

Offsets

MRU to Transducer

x -0.455 meters

y 4.620 meters

z 1.383 meters

x2 -12.701 meters

y2 4.620 meters

z2 1.381 meters

Nav to Transducer

x 2.649 meters

y 1.920 meters

z 14.303 meters

x2 -9.597 meters

y2 1.920 meters

z2 14.301 meters

Transducer Roll
Roll 0.000 degrees

Roll2 0.000 degrees

C.1.2 Layback

C.1.2.1 Description of Correctors

Layback is calculated in CARIS from the cable-out and fish depth. Cable-out is output from a cable counter
 and recorded in the .sdf file.  The side scan cable is marked at 12 meters and is deployed to this position on
 launching. The cable counter is reset to zero at this position and the 12 meter offset applied in SonarPro.
 Thus, the cable out value in the .sdf file is the correct value for the cable between the tow point and the
 towfish.

C.1.2.2 Methods and Procedures



2013 DAPR Version 1           NOAA Ship Ferdinand R. Hassler                

65

No layback correctors are applied in the HVF

C.1.2.3 Layback Correctors

Vessel S250

Echosounder Klein 5250 455 kilohertz

Date 2013-07-01

Layback
Towpoint

x 7.161 meters

y -26.032 meters

z -9.347 meters

Layback Error 0.00 meters

Additional Discussion

C.2 Static and Dynamic Draft

C.2.1 Static Draft

C.2.1.1 Description of Correctors

Because of her SWATH design, FERDINAND R. HASSLER is particularly susceptible to loading and
 trim. While underway, the ballast is actively managed to maintain the draft at the design draft of 3.80
 meters. During typical survey operations, HASSLER burns approximately 4,000 liters of diesel per day.
 At a density of 0.83 kilograms/ liter this is approximately 3.3 metric tons of fuel per day. At design draft
 of 3.80 meters, 1.3 metric tons is required to submerge an additional 0.01 meters of the hull in salt water.
 The daily fuel burn would thus account for 0.03 meters of variation in the draft. Ballast is adjusted daily to
 account for fuel burn and the levels in other tanks. As noted in Section A.1.1, design draft of 3.85 meters
 was mistakenly used to compute static draft of the reference point.  The resulting bias is not considered
 significant for this survey.  Uncertainty is estimated at 0.05 meters. 

C.2.1.2 Methods and Procedures

The waterline to reference point is calculated from the vessel offset survey and the vessel draft marks.

C.2.2 Dynamic Draft

C.2.2.1 Description of Correctors
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Dynamic draft is calculated as the dynamic height of the vessel reference point as a function of vessel speed
 compared to the height at rest.  This correction is applied during CARIS processing. 

C.2.2.2 Methods and Procedures

An ellipsoidally referenced dynamic draft measurement (ERDDM) was performed following guidelines in
 the 2013 FPM on June 26, 2013 (Dn177).  An area was selected offshore of Cape Charles, VA where the
 slope of the geoid was minimal.  Speeds from 6 to 13 knots were run in one direction.  The ship was then
 turned to the reciprocal heading, brought to a complete stop, and then the speeds from 6 to 13 knots were
 run in the opposite direction. 

The fourth order polynomial results for the dynamic draft curves from the port and starboard side were
 averaged.  These results were significantly different from the 2011 and 2012 values, with a 0.15 meter
 difference at typical survey speeds from the prior year.  This may be accounted for by the significant
 changes made to the hull during the off season drydock for added buoyancy.  The 2013 results are included
 in the attached report and shown in Figure 26.

C.2.2.3 Dynamic Draft Correctors

Vessel S250

Date 2012-01-01

Dynamic
Draft Table

Speed
0.0 meters/
second

1.0 meters/
second

2.0 meters/
second

3.0 meters/
second

3.5 meters/
second

4.0 meters/
second

4.5 meters/
second

5.0 meters/
second

5.5 meters/
second

6.0 meters/
second

6.5 meters/
second

Draft 0.000 meters0.010 meters-0.110 meters-0.180 meters-0.170 meters-0.130 meters-0.070 meters0.010 meters0.090 meters0.160 meters0.180 fathoms

Additional Discussion
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Figure 27: Dynamic draft derived from ERDDM methods. Positive values are displacements
of the IMU towards the sea floor. Thin lines are results from port and starboard head for third

and fourth order polynomial fits. Black bold line is dynamic draft value used for both hulls.

C.3 System Alignment

C.3.1 Description of Correctors

C.3.2 Methods and Procedures

Methods and Procedures used follow recommendations given in Section 1.5 of the 2013 FPM.

C.3.3 System Alignment Correctors

Vessel S250

Echosounder Reson 7125 Starboard 400 megahertz

Date 2013-10-20
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Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch -0.190 degrees

Roll 0.100 degrees

Yaw 0.510 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder Reson 7125 Starboard 400 kilohertz

Date 2013-07-25

Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch -0.190 degrees

Roll 0.010 degrees

Yaw 0.510 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder Reson 7125 Starboard 200 kilohertz

Date 2013-07-31

Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch 0.050 degrees

Roll 0.010 degrees

Yaw 0.620 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder Reson 7125 Port 400 kilohertz

Date 2013-10-20
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Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch -0.390 degrees

Roll -0.080 degrees

Yaw 0.090 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder Reson 7125 Port 400 kilohertz

Date 2013-07-25

Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch -0.390 degrees

Roll -0.020 degrees

Yaw 0.090 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder Reson 7125 Port 200 kilohertz

Date 2013-07-31

Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch 0.160 degrees

Roll 0.000 degrees

Yaw -0.07 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

Vessel S250

Echosounder Reson 7111 100 kilohertz

Date 2013-07-31
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Patch Test Values

Navigation Time
Correction

0.000 seconds

Pitch -0.880 degrees

Roll -0.020 degrees

Yaw 1.610 degrees

Pitch Time Correction 0.000 seconds

Roll Time Correction 0.000 seconds

Yaw Time Correction 0.000 seconds

Heave Time Correction 0.000 seconds

C.4 Positioning and Attitude

C.4.1 Description of Correctors

C.4.2 Methods and Procedures

Vessel navigation and attitude is measured by the POS/MV and recorded in the Hysweep .hsx file and the
 Reson .s7k file.  Pitch is applied real-time to the Reson 7111.  Navigation and attitude measurements not
 applied in real time are applied during post processing in CARIS HIPS using the attitude data recorded in
 the .hsx or .s7k file.  

The POS/MV TrueHeave data is logged within the POS/MV .000 files and applied in CARIS HIPS during
 post processing using the "Apply TrueHeave" function.  TrueHeave is a forward-backward filtered heave
 corrector as opposed to the real time heave corrector, and is fully described in section 6 of the POS/MV V4
 User Guide 2009. 

In most cases, PPK data in the form of SBET files are applied to soundings to increase the accuracy of
 the kinematic vessel corrections and to allow the ability to reference soundings to the ellipsoid.  Standard
 daily data processing procedures include post processing of POS/MV kinematic .000 files using Applanix
 POSPac MMS and POSGNSS software using either IN-Fusion SmartBase, IN-Fusion SingleBase or Precise
 Point Positioning (PPP) processing modes.  After processing and quality control analysis of the post-
processed SBET files is complete, the SBET and SMRMSG files are applied to the HDCS data in CARIS
 HIPS using the "Load Attitude/Navigation Data" and "Load Error Data" processing tools, respectively.  

The heave lever arms are configured to a point on the centerline of the vessel between the two POS IMU's. 
 This was done to prevent long-term static roll angles from causing a steady state heave offset.

C.5 Tides and Water Levels

C.5.1 Description of Correctors
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C.5.2 Methods and Procedures

Unless otherwise noted in the survey Descriptive Report (DR) and/or project Horizontal and Vertical Control
 Report (HVCR), the vertical datum for all soundings and heights is Mean Lower Low Water (MLLW). 
 Predicted, preliminary, and/or verified water level correctors from the primary tide station(s) listed in the
 Project Instructions may be downloaded from the CO-OPS website and used for water level corrections
 during the course of the project.  These tide station files are collated to include the appropriate days of
 acquisition and then converted to CARIS .tid file format using FetchTides.

Water level data in the .tid files are applied to HDCS data in CARIS HIPS using the zone definition file
 (.zdf) or a Tidal Constituent and Residual Interpolation (TCARI) model supplied by CO-OPS.  Upon
 receiving final approved water level data, all data are reduced to MLLW using the final approved water
 levels as noted in the individual survey's DR.

A complete description of vertical control utilized for a given project can be found in the project specific
 HVCR, submitted for each project under separate cover when necessary as outlined in section 5.2.3.2.3 of
 the FPM.

Newer methods for handling vertical control are being developed and, if utilized, are explained in more
 detail in the project-wide HVCR or survey DR.

C.6 Sound Speed

C.6.1 Sound Speed Profiles

C.6.1.1 Description of Correctors

C.6.1.2 Methods and Procedures

Seabird .cnv and MVP .bot files are collected when necessary and converted to .svp files using NOAA's
 Pydro/Velocipy program.  These .svp files are concatenated into one sheet specific master file per project
 which is then applied to HDCS data using a specified method.  This method of applying sound speed to data
 is listed in the sheet's processing log included in the Separates submitted with the individual survey.

C.6.2 Surface Sound Speed

Surface sound speed correctors were not applied.



                                                         
 

D. APPROVAL SHEET 
 
 
This Data Acquisition and Processing Report for project OPR-B310-FH-13, Approaches to 
New York, is respectfully submitted. 
 
As Chief of Party, I have ensured that standard field surveying and processing procedures were 
adhered to during these projects in accordance with the Hydrographic Surveys Specifications 
and Deliverables (4/2013); Hydrographic Survey Technical Directives 2010-2, 2011-3, 2012-
1; and the Field Procedures Manual for Hydrographic Surveying (4/2013). 
 
I acknowledge that all of the information contained in this report is complete and accurate to 
the best of my knowledge. 
 
This DAPR applies to surveys H12627, H12628, and H12629 which were completed in 2013.   
 
Approved and Forwarded: 
 
 

 
_________________________________     _________________________________ 
LT Adam Reed, NOAA       LCDR Marc S. Moser, NOAA 
Field Operations Officer       Chief of Party 
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Final report 
 

SURVEY REPORT 
 
SHIP: M286 SWATH 
FERDINAND R. HASSLER 
 
LOCATION:  PASCAGOULA, MS 
 
DATE:  7/18-7/26, 2009 
And          11/4, 2009 
 
 
PURPOSE: 
   Determine the ship’s centerline, roll, and pitch. Install benchmarks,  install the master 
reference plane in the same planes as the measured roll, pitch, and azimuth of the ship. Assist the 
shipyard to install the IMUs parallel to the centerline, and in the same plane as the ship’s roll and 
pitch. Assist the shipyard in installing the transducers in the same plane as roll, pitch and azimuth 
of the ship. Measure and spot the draft marks. 
 
PERSONNEL:   
    Eric Kostelak 
    Brian Kloter 
    Raymond Impastado 
    John Miskimmin 
     
            
 
EQUIPMENT LIST: 
      WILD T2 THEODOLITE  SN:  169786  Calibration Expiration Date; 12/19/09 
         
 
       WILD T2 THEODOLITE  SN:  155062  Calibration Expiration Date; 12/19/09 
 
       WYLER CLINO 2000 CLINOMETER  SN: M4416  Calibration Expiration 
                                                                                                         Date; 07/10/10                                                    
                                                                                                      
       TOPCON GTS-301 One Second Electronic Total Station, Serial number GU1193 
                                                                          Calibration Expiration Date; 07/12/09 
 
       WILD NA1 AUTO LEVEL: SN 472810   Calibration Expiration Date; 07/12/09 
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Procedures: 
 
       1.  Establish a baseline in relation to the centerline of both pontoons. 
               A. Locate points on each of the pontoons to determine centerline 
               B. Measure the elevation differences of the points. Take the average of  
                    these to determine the pitch and roll of each pontoon. 
                     
       2.  Take the average of the measurements of the two pontoons for roll, pitch, 
             and centerline. The result can then be used as the Master reference.  
 
       3.  Create a traverse, in a level plane, around the ship using the established 
             baseline as a reference. Set various points that will be used to locate the 
             master reference block, IMUs, bench marks, transducers, and antennas. 
 
       4.  Locate, set and secure the master reference block to within 9 arc seconds 
            of the calculated roll, pitch, and centerline values. 
 
      5. Once the MRB has set for a day, confirm the measurements relative to the  
            results of step 2. If the measurements are within the two values used in  
            Step 2, these values will become the Final Master Reference, which all  
            further measurements will be referenced to. 
 
       6.  Locate IMU foundations, adjust to be level with roll and pitch, and aligned 
            with centerline. 
 
      7.  Establish bench marks that are aligned to the centerline in any areas that require  
           future measurements. 
 
       8. For transducers, on the bottom of the hull, establish punch marks aligned to the  
           centerline that can be used to align the transducers to the centerline. 
 
      9.  Run a closed level loop from the master reference block to all bench marks, 
           Transducers, antennas, and sensors to determine their elevation values 
            relative to the reference. (Z axis). 
 
     10. Using established elevation points within the traverse, determine the correct  
            locations for all draft marks. 
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     11. Work with the shipyard to determine the correct alignment of the transducers. 
 
METHODS 
    
          All angles at intersections were turned 4 times, 2 in regular, and 2 in inverted 
          position. All other angles were turned 2 times, once in regular, and once in  
          inverted position.  
 
           
 
          Slope distances were measured with a zenith angle in the regular and inverted  
          Position. 
 
           The Traverse was closed and computed for accuracy. 
 
 

Results 
 

MRB 
After the MRB has set up for 24 hours, it was found the chock fast had caused an 18 second 
movement in roll. As this small value was well within the average of the two pontoons, the final 
reference was shifted to the MRB values. 
 
IMU 
During measurements of the IMUs, we discovered it was impossible to meet the specification to 
be level to the roll and pitch within 90 arc seconds using the existing mounts. The shipyard 
manufactured a double plate separated by three threaded rods, which allowed fine 
adjustment in two planes (roll and pitch). The IMUs were aligned to zero measurable 
azimuth error, and to within 5 arc seconds in roll and pitch relative to the MRB. 
 
TRANSDUCERS 
7125 
 During measurements it became apparent that it was impossible to meet the roll and pitch 
specification on the multibeam transducer mounts. There was no measurable azimuth error on 
either 7125 transducer mount, when the welding was finished. The shipyard came up with the 
roll and pitch solution of machining the surfaces in place once the mounting plates were 
completely welded out. We attended for the machine work on 8/19/09. A portable milling 
machine was put in place, leveled to within 5 arc seconds of the MRB plus 4.5 degrees of roll to  
Give the transducer mounting surfaces the specified 4.5 degree outward roll angle. See attached 
photo. It was agreed by all that if the milling machine was positioned correctly, the surfaces had 
to be correct, but as a check to confirm the process, we measured the machined surface on the 
port unit, and found the pitch error was zero, and the roll error was 15 seconds. This was well 
within the required 90 seconds. 
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Milling machine set up on 7125 transducer housing 

 
 
 
 
7111 
 
Like the 7125s, it was impossible to meet the roll and pitch specification on this transducer 
mounting plate. It too, was machined by the portable milling machine. 
The machine was set up to be within 5 seconds of the MRB Pitch and Roll values. 
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                              XYZ COORDINATES TABLE 
 

POINT X-AXIS Y-AXIS Z-AXIS DESCRIPTION 
5 9.264 -7.555 7.169 POINT FP 
6 9.409 6.256 7.168 POINT FS 
7 3.491 -7.478 7.176 POINT MP 
8 3.872 6.168 7.178 POINT MS 
9 -4.035 -7.561 7.168 POINT AP 

10 -4.022 6.258 7.169 POINT AS 
15 9.326 -0.652 7.168 CENTERLINE 
18 -4.017 -0.652 7.168 CENTERLINE 
19 16.343 2.530 -5.065 STARBOARD BENCH MARK TOP WHEEL HOUSE 
20 16.343 -0.653 -5.064 MID BENCH MARK TOP WHEEL HOUSE 
21 16.343 -3.836 -5.066 PORT BENCH MARK TOP WHEEL HOUSE 
25 -1.336 0.001 0.160 AFT BENCH MARK MASTER REFERENCE PLATE 
26 0.000 0.000 0.000 MASTER REFERENCE PLATE 
27 -0.353 0.000 0.161 FWD BENCH MARK MASTER REFERENCE PLATE 
28 13.428 -8.960 -2.496 PORT BENCH MARK BRIDGE WING 
29 13.428 -5.592 -2.476 STARBOARD BENCH MARK BRIDGE WING 
30 7.115 5.836 7.154 FWD PUNCH MARK ADCP 
31 5.765 5.835 7.145 AFT PUNCH MARK ADCP 
33 7.841 6.846 7.167 FWD PUNCH MARK RESON 7125 STARBOARD PONTOON 
34 5.025 6.847 7.168 AFT PUNCH MARK RESON 7125 STARBOARD PONTOON 
36 5.022 -8.169 7.157 AFT PUNCH MARK RESON 7125 PORT PONTOON 
37 7.792 -8.169 7.154 FWD PUNCH MARK RESON 7125 PORT PONTOON 
39 15.307 6.610 6.843 AFT PUNCH MARK RESON 7111 
40 16.098 6.611 6.771 FWD PUNCH MARK RESON 7111 
41 10.822 5.864 7.169 FWD PUNCH MARK MDS* STARBOARD PONTOON 
42 9.818 5.863 7.172 AFT PUNCH MARK MDS* STARBOARD PONTOON 
43 10.608 -7.081 7.177 FWD PUNCH MARK MDS* PORT PONTOON 
44 9.762 -7.080 7.175 AFT PUNCH MARK MDS* PORT PONTOON 
45 -13.926 -0.615 0.105 AFT MID BENCH MARK BACK DECK 
46 -9.031 -0.615 0.125 FWD BENCH MARK BACK DECK 
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POINT X-AXIS Y-AXIS Z-AXIS DESCRIPTION 

47 -13.926 6.471 0.114 STARBOARD BENCH MARK BACK DECK 
48 -13.926 -7.697 0.093 PORT BENCH MARK BACK DECK 
51 5.891 -6.878 5.839 IMU PORT PONTOON (OLD LOCATION) 
52 5.923 5.428 5.840 IMU STARBOARD PONTOON (OLD LOCATION) 
53 17.655 6.584 6.890 RESON 7111 CENTER OF PLATE 
54 6.265 6.774 7.095 PORT EDGE RESON 7125 STARBOARD PONTOON 
55 6.265 6.805 7.093 RESON 7125 STARBOARD PONTOON 
56 6.223 -8.078 7.087 STARBOARD EDGE RESON 7125 PORT PONTOON 
57 6.223 -8.109 7.085 RESON 7125 PORT PONTOON 
58 16.039 5.417 2.563 INBOARD DRAFT MARK FRAME 4 STARBOARD 
59 16.025 -6.711 2.567 INBOARD DRAFT MARK FRAME 4 PORT 
60 -11.204 5.626 2.588 INBOARD DRAFT MARK FRAME 46 STARBOARD 
61 -11.208 -6.870 2.562 INBOARD DRAFT MARK FRAME 46 PORT 
62 16.040 7.458 2.565 OUTBOARD DRAFT MARK FRAME 4 STARBOARD 
63 -11.208 7.462 2.588 OUTBOARD DRAFT MARK FRAME 46 STARBOARD 
64 16.025 -8.735 2.570 OUTBOARD DRAFT MARK FRAME 4 PORT 
65 -11.205 -8.711 2.555 OUTBOARD DRAFT MARK FRAME 46 PORT 
66 6.273 -9.907 5.789 PORT BENCH MARK IMU PORT PONTOON 
67 6.273 -5.007 5.861 STARBOARD BENCH MARK IMU PORT PONTOON 
68 6.624 3.666 5.862 PORT BENCH MARK IMU STARBOARD PONTOON 
69 6.624 8.571 5.798 STARBOARD BENCH MARK IMU STARBOARD PONTOON 
70 5.861 -6.865 5.767 IMU PORT PONTOON 
71 5.885 5.381 5.768 IMU STARBOARD PONTOON 
72 -20.247 -0.609 -4.327 BOTTOM OF CENTER BLOCK "A" FRAME 
73 11.205 -1.904 -7.782 BOTTOM OF GPS ANTENNAE PORT LOWER 
74 10.488 -1.896 -9.774 BOTTOM OF GPS ANTENNAE PORT UPPER 
75 11.180 0.594 -7.776 BOTTOM OF GPS ANTENNAE STARBOARD LOWER 
76 10.455 0.589 -9.776 BOTTOM OF GPS ANTENNAE STARBOARD UPPER 
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NOAA Ship Hassler 
POS Antenna and Spatial Relationship Survey  
 
PURPOSE 
 
The intention of this survey was to accurately position the relocated POS Antennas 
and Side Scan Sonar tow point. 
 
PROJECT DETAILS 
 
This survey was conducted on March 29, 2011 on Spring River Island in 
Pascagoula, MS.  NGS was provided data from a previous survey that contained a 
complete point listing of all components as well as recoverable bench mark 
stations.  The NOAA Ferdinand Hassler was in water causing some instability of 
the instrument and target reflectors.  The tilt compensator had to be bypassed in 
order to take measurements.       
 
INSTRUMENTATION 
 
The TOPCON GPT 3000 Series Total Station was used to make all measurements. 

A SECO 25 mm Mini Prism System configured to have a zero mm offset was used 
as target sighting and distance measurements. 

SOFTWARE AND DATA COLLECTION 

TDS Survey Pro Ver. 4.7.1 

ForeSight DXM Ver. 3.2.2 was used for post processing.  

PERSONNEL 

Kevin Jordan NOAA/NOS/NGS/Field Operations Branch 757-441-5478 

Doug Adams NOAA/NOS/NGS/Field Operations Branch 757-441-5480 

 

 
 
 
 
 



NOAA Ship Hassler 
POS Antenna and Spatial Relationship Survey  
 

SURVEY PROCEDURES 
 
RECOVERED STATIONS 
 
MID BENCH MARK TOP WHEEL HOUSE 

 
 
PORT BENCH MARK TOP WHEEL HOUSE 

 
 
STARBOARD BENCH MARK TOP WHEEL HOUSE 



 
 
AFT MID BENCH MARK BACK DECK 

 
 
PORT BENCH MARK BACK DECK 



 
 
STARBOARD BENCH MARK BACK DECK 

 
 
 



PORT BENCH MARK BRIDGE WING 
-NO PHOTOS OF THIS STATION 
 
NEW FEATURES 
 
PORT POS ANTENNA MOUNT 

 
 
 



STARBOARD POS ANTENNA MOUNT 

 
 
 
 
 
 



SIDE SCAN SONAR TOW POINT 
-Horizontal Survey Point (HSP) 
-Vertical Survey Point (VSP) 

 
 
 

 



Setup #1 
Using the coordinates from the previous survey, the field crew setup the theodolite 
on the MID BENCH MARK TOP WHEEL HOUSE and initialized on PORT 
BENCH MARK BRIDGE WING to obtain a starting azimuth.  From this setup, we 
collected the four POS antenna mount locations:  

PORT FWD ANTENNA 
PORT AFT ANTENNA 
STARBOARD FWD ANTENNA 
STARBOARD AFT ANTENNA 

 
Positional checks were made to bench mark stations (see attached comparison 
report): 

PORT BENCH MARK TOP WHEEL HOUSE 
STARBOARD BENCH MARK TOP WHEEL HOUSE 
PORT BENCH MARK BRIDGE WING 
 

A temporary point (TP1) was established on the flying bridge near the stairs in 
order to collect the location of the SIDE SCAN SONAR TOW POINT. 
 
Setup #2 
The field crew setup on TP1 and initialized on the MID BENCH MARK TOP 
WHEEL HOUSE.  From this setup, we collected: 

SIDE SCAN SONAR TOW POINT 
 

Positional checks were made to bench mark stations (see attached comparison 
report): 

MID BENCH MARK TOP WHEEL HOUSE  
AFT MID BENCH MARK BACK DECK 
 

Setup #3 
The field crew setup on AFT MID BENCH MARK BACK DECK and initialized 
on TP1.  Positional checks were made to bench mark stations (see attached 
comparison report): 

PORT BENCH MARK BACK DECK 
STARBOARD BENCH MARK BACK DECK 

 
 
 
 
 
 
 



DISCUSSION 
All sensor/benchmark coordinates are contained in spreadsheets “NOAA SHIP 
HASSLER.xls”   
 
The following table includes stations that were observed from more than 
one setup and for each, an inverse was computed to identify possible 
setup errors.  Each station checked with favorable results. 
 

OBSERVED to PUBLISHED COMPARISON (Units in Meters) 
NAME ∆ Northing  ∆ Easting  ∆ Elevation  

PORT BENCH MARK 
BRIDGE WING -0.003 -0.008 0 
PORT BENCH MARK 
TOP WHEEL HOUSE 0.030 -0.015 -0.003 
STARBOARD BENCH 
MARK TOP WHEEL 
HOUSE -0.026 0.010 -0.006 
MID BENCH MARK 
TOP WHEEL HOUSE 0.015 0.002 -0.007 
AFT MID BENCH 
MARK BACK DECK -0.020 -0.030 0.011 
PORT BENCH MARK 
BACK DECK 0.027 -0.002 -0.005 
STARBOARD BENCH 
MARK BACK DECK -0.015 0.018 -0.011 

 



NEW GPS IMU ‐ NGS 2012

IMU PORT

DESCRIPTION X Y Z

STAR FWD ANT 2.722 9.162 ‐12.869

STAR AFT ANT 0.719 9.159 ‐12.895

PORT FWD ANT 2.712 1.05 ‐12.838

PORT AFT ANT 0.706 1.052 ‐12.853

STARBOARD BM TOP OF WHEEL HOUSE 10.482 9.395 ‐10.832

PORT BM TOP OF WHEEL HOUSE 10.482 3.034 ‐10.807

IMU STBD

DESCRIPTION X Y Z

STAR FWD ANT 2.698 ‐3.084 ‐12.87

STAR AFT ANT 0.695 ‐3.087 ‐12.896

PORT FWD ANT 2.688 ‐11.196 ‐12.839

PORT AFT ANT 0.682 ‐11.194 ‐12.854

STARBOARD BM TOP OF WHEEL HOUSE 10.458 ‐2.851 ‐10.833

PORT BM TOP OF WHEEL HOUSE 10.458 ‐9.212 ‐10.808
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PURPOSE 

During the 2012 field season it was discovered that previously determined offsets from the original ship 
survey (Impastato, 2009) were in need of refinements.  Results from 2012 post‐processed POSPac 
derived offset solutions and ellipsoidally referenced leadline (ERLL) measurements showed a difference 
of approximately 20 centimeters in the vertical direction.  This error was floating somewhere between 
the navigation GPS antennas, IMU and transducers.  An attempt to track down this error was performed 
by Ferdinand R. Hassler personnel during the drydock period (April 2013) at Colonna’s Shipyard in 
Norfolk, VA. 

METHODS 

A calibrated optical level was utilized to obtain a closed loop of elevations on important points and 
sensors around the ship.  These elevations are with respect to gravity, in order to transform them to the 
ship’s reference frame (SRF) an additional loop was obtained containing known benchmark elevations.  
From these benchmark elevations, values for pitch and roll were computed. 

The primary sensor loop contained elevations from the starboard forward (primary) POS antenna on the 
flying bridge to a temporary benchmark (TBM) located on the drydock floor.  From the TBM the loop 
proceeded to close by way of the port forward POS antenna and a final closing shot between the two 
antennas.  This resulted in a closed loop with less than 5 millimeters of calculated misclosure. 

The TBM on the drydock floor was utilized for spurs to survey sensors.  Each individual sensor was 
treated separately and closed with a misclosure computed in the calculation spreadsheet.  Both IMU’s 
was measured using a level and tape measure from known point via the cable route (7125’s and cables 
were removed for shipyard period).  The 7125 elevations were computed from the averaged elevation 
readings on the inboard and outboard base of frame, accounting for the manufactured 4.5 degree tilt. 

A total station was utilized to obtain elevations on all eight draft marks permanently fixed on the ship’s 
hull.  A reflectorless (laser) measurement device measured the vertical distance relative to a level 
gravimetric plane of the instrument.  

To obtain results a couple of points were assumed: 

1) The ship reference frame is accurately documented and defined from the Impastato ship survey.  
From the established benchmarks we are able to recreate the ship reference frame and apply 
pitch/roll calculations correctly. 

2) Coordinates provided from Impastato are correct until proven otherwise.  We use distances 
from the master reference block (MRB) for applying the pitch/roll offsets but strongly disagree 
with many of his z‐coordinates.  Also, along with #1; benchmarks utilized were crucial in 
recreating the ships reference frame. 

3) Distances from the MRB for applying pitch/roll offsets is close enough to the center of gravity 
for the vessel to accurately apply pitch and roll. 
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4) The Hassler is located in a floating drydock which is subject to outside influences (e.g. tide, 
current, wind).  However, the influences will affect both drydock and ship at the same rate and 
therefore be negligible. 

RESULTS 

Ship Reference Frame: 

One of the primary issues with surveying a ship is orientating results obtained via outside reference 
frames (e.g gravity) into the SRF.  During the Impastato ship survey, the surveyor defined the ship’s 
master reference frame by measuring the pitch and roll of each pontoon and averaging these values.  
From this point he established various benchmarks located around the vessel; including the MRB, IMU 
plates, transducers and antennas.  It is from this original survey benchmarks that enable us to transform 
coordinates relative to the SRF. 

A level loop was run from a benchmark established by FH personnel on the bow of the Hassler to two 
benchmarks established by Impastato on the aft corners.  From these three benchmarks we figured the 
difference of design slope to actual slope for both pitch and roll.  The correction was corrected with the 
distance from the MRB, which is near but not located at the center of gravity (motion) for the vessel.  
This appears to be the same strategy utilized by Impastato during the original survey.   

Ship Sensors: 

Through careful analysis of the main level loop and the spurs to each individual sensor located on the 
pontoons, the following offsets were obtained. 

Sensor 
Corrected height from 

Antenna Base 
Corrected height from  

IMU 
Port IMU (base of plate)  ‐12.990  Port  ‐‐  ‐‐ 

Starboard IMU (base of plate)  ‐12.990  Starboard  ‐‐  ‐‐ 
7125 Port (middle Rx)  ‐14.203  Port  ‐1.213  Port 

7125 Starboard (middle Rx)  ‐14.212  Starboard  ‐1.222  Starboard 
7111 (middle Rx)  ‐14.149  Starboard  ‐1.159  Starboard 

Port VBES  ‐14.236  Starboard  ‐1.245  Starboard 
Starboard VBES  ‐14.237  Starboard  ‐1.247  Starboard 

Table 1: 2013 Sensor Offset Results 

Comparisons were made from the 2013 sensor offset results with offsets used previously during the 
2012 season.   Two sets of z‐offsets were used during the 2012 season; those obtained through 
Impastato ship survey coordinates and those obtained through post‐processed POSPac results 
(supported through ERLL results).  The results of the delta Z values (2013 minus 2012) are shown below 
in Table 2. 
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Sensor 
Delta Z (m) 
(Impastato) 

Delta Z (m) 
(Revised) 

Notes and Analysis 

Stbd IMU ‐> 
Stbd APC 

0.225  ‐0.002 
Revised measurements from POSPac and ERLL; 2013 
survey values strongly agree with revised results. 

Port IMU ‐> 
Port APC 

0.212  ‐0.019 
Revised measurements from POSPac; 2013 survey values 
strongly agree with revised results. 

Stbd IMU ‐> 
7111 Rx 

‐0.171  n/a 
No revisions were made between the Stbd IMU and 7111 
Rx. 

Stbd APC ‐> 
7111 Rx 

0.176  n/a 
No revisions were made between the Stbd APC and 7111 
Rx. 

Stbd IMU ‐> 
7125S Rx 

‐0.103  ‐0.011 
Revised measurements were never used; 2013 survey 
values show disagreement between IMU and sensor. 

Stbd APC ‐> 
7125S Rx 

0.244  ‐0.105 
Revised measurements from POSPac and ERLL; 2013 
survey values show same disagreement between IMU and 
sensor. 

Port IMU ‐> 
7125P Rx 

‐0.105  0.011 
Revised measurements were never used; 2013 survey 
values show disagreement between IMU and sensor. 

Port APC ‐> 
7125P Rx 

0.229  ‐0.123 
Revised measurements from POSPac; 2013 survey values 
show same disagreement between IMU and sensor. 

Table 2: Delta Values between 2013 and 2012 

 Draft Marks: 

Field elevation measurements were corrected using the same pitch and roll constants as stated earlier.  
For this calculation the X/Y locations of the draft marks were obtained from Impastato ship survey. 

Forward Port 
Outboard 

Forward Port 
Inboard 

Forward Stbd 
Inboard 

Forward Stbd 
Outboard 

2.57  2.58  2.52  2.52 
2.77  2.78  2.71  2.71 
2.97  2.98  2.92  2.91 
3.16  3.18  3.12  3.11 
3.37  3.38  3.32  3.30 
3.57  3.58  3.52  3.51 
3.77  3.78  3.71  3.71 
3.97  3.98  3.92  3.91 
4.17  4.18  4.12  4.11 
4.37  4.38  4.32  4.31 
4.57  4.58  4.52  4.51 
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After Port 
Outboard 

After Port 
Inboard 

After Stbd 
Inboard 

After Stbd 
Outboard 

2.58  2.58  2.61  2.59 
2.78  2.77  2.81  2.80 
3.99  2.97  3.01  2.99 
3.18  3.17  3.21  3.20 
3.38  3.37  3.41  3.40 
3.58  3.57  3.61  3.60 
3.79  3.78  3.81  3.80 
3.98  3.98  4.01  4.00 
4.18  4.18  4.21  4.20 
4.38  4.38  4.41  4.40 
4.58  4.58  4.61  4.60 

Table 3: Draft Mark Elevations relative from MRB (z is positive down) 

Ship Traverse: 

While in our possession the total station instrument was utilized for a ship traverse of existing 
benchmarks and POS antennas; as well as recreating the original SRF from the Impastato survey.  
Methods for this traverse were not as complete as was desired due to inadequate equipment and 
training of personnel.  However, the calculations serve as additional checks against prior surveys and 
because an X/Y position was established on the TBM, help tie all previously discussed methods into a 
complete survey.  More calculations are required on these acquired data once defined goals are 
obtained. 

CONCLUSIONS 

Vertical offsets from the level loop agree closely with offsets derived from post‐processed POSPac 
solutions and ERLL calculations resulting in more confidence of both these methods.  Hours were spent 
overlooking Impastato’s original survey notes for any indication of possible errors or blunders but none 
were found.  From these results it is safe to say that there were errors and possibly an overall 
miscommunication of exact reference points for measurement.  Ferdinand R. Hassler’s 2013 offsets will 
be defined from an in‐depth analysis of these results and subsequent ERLL and reference surfaces to be 
acquired during Hydrographic Systems Readiness Review 2013. 

Draft marks appear to near locations defined by Impastato as well as being generally level with respect 
to the ship reference frame; however, it appears that there is a disagreement with the forward 
starboard draft marks.  



Offsets: POS MV

Measurement

Coord. Sys. Caris POSMV Caris POSMV Caris POSMV Caris POSMV (from calc) (from calc)
x 1.002 2.713 ‐3.104 2.700 NA NA NA NA Scaler Distance 2.000 Scaler Distance 2.006
y 2.713 1.002 2.700 ‐3.104 NA NA NA NA
z ‐12.920 ‐12.920 ‐12.920 ‐12.920 NA NA NA NA

(from GAMS Cal) (from GAMS Cal)
Scaler Distance Scaler Distance

Calculations

x 0.000 x 0.000 Port IMU to Fwd Port Ant Stbd IMU to Fwd Stbd Ant Port y 6.123
y 0.000 y 0.000 (from 2013 calculations) (from 2013 calculations) STBD y ‐6.123
z 0.1236 z 0.1236 x 2.713 x 2.700

(in POSMV) (in POSMV) y 1.002 y ‐3.104 x and z zero
z ‐12.920 z ‐12.920

x 0.000 x 0.000
y 0.000 y 0.000 Port IMU to Fwd Port Ant Stbd IMU to Fwd Stbd Ant
z 0.012 z 0.012 (from PosPac calibration) (from PosPac calibration)

(in POSMV) (in POSMV) average average
x x

x 2.713 x 2.700 y y
y 1.002 y ‐3.104 z z
z ‐12.990 z ‐12.990 *calculated averages between multiple days

(in POSMV) (in POSMV)

x 0.000 x 0.000 Ref to Center of Rotation
y 0.000 y 0.000 (Top of Stbd IMU to Center of Rotation)
z ‐0.066 z ‐0.066 POSMV

(in POSMV) (in POSMV) ‐3.705
‐6.033
‐2.270

x 2.713 x 2.700 (from waterline )
y 1.002 y ‐3.104 Added to Pos on DN285 2012
z ‐12.920 z ‐12.920

(in POSMV) (in POSMV)

Top of Port IMU to Fwd Port Ant Top of Stbd IMU to Fwd Stbd Ant

Top of Port IMU 
to aft port ant 
phase center

Top of Stbd 
IMU to fwd port 

ant phase 
center

Adapter Plate 

from physical measurement

Adapter Plate

from physical measurement

(x/y from 2012 POSPac, z from 
FH 2013 drydock 
measurements)

(x/y from 2012 POSPac, z from 
FH 2013 drydock 
measurements)

Antenna base 
to phase 
center

Antenna base 
to phase 
center

(from Trimble diagram) (from Trimble diagram)

Adapter Plate  
to top of IMU

Adapter Plate  
to top of IMU

(from POSMV V5 User Guide) (from POSMV V5 User Guide)

Center of Port 
IMU Plate to 

Fwd Port 
Antenna Base

Center of Stbd 
IMU Plate to 

Fwd Stbd 
Antenna Base

Stbd Ant Seperation Port Ant Seperation

POSMV offsets are derived from measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.

Port IMU to Fwd Port Ant Stbd IMU to Fwd Stbd Ant PosPac Derived Offsets

Port Ant SeperationPort IMU to Fwd Port Ant Stbd IMU to Fwd Stbd Ant Stbd IMU to Heave Stbd IMU to Heave Stbd Ant Seperation



Offsets: Port 7125

Measurement
Coord. Sys. Caris Caris Reson Hypack

x -1.244 -2.246 0.000 Stbd -1.244
y 0.362 -2.351 -0.441 Fwd 0.362
z 1.349 14.269 0.047 Vertical 3.780

TILTED 4.5 degrees up to port TILTED 4.5 degrees up to port
*Top of IMU is RP (Reference Pt)

Calculations

x 0.000 x -1.002 x 0.000 x -1.244

y 0.000 y -2.713 y 0.000 y 0.362

z 0.1356 z 12.920 z 0.000 z 1.349
(in CARIS) (in CARIS) (in Reson) (in CARIS)

x -1.244 x -1.244 x 0.000 x 0.000

y 0.362 y 0.362 y 0.441 y 0.000
z 1.213 z 1.349 z -0.047 z 2.431

(in CARIS) (in CARIS) (in Reson) (in Hypack)

x -1.244 x -2.246 x 0.000 x -1.244
y 0.362 y -2.351 y -0.441 y 0.362

z 1.349 z 14.269 z 0.047 z 3.780
(in CARIS) (in CARIS) (in Reson) (in Hypack)

*CALCULATION NOTES*
Z calc includes 0.015 m from base to RP 0.102 from Reson diagram - Rx width

Impastato X/Y measurement locations unknown 0.25 from 2013 drydock - Gap between Rx and Tx

0.28 from Reson diagram - Tx length

0.003656 4.5° tilt calculated from Tx diameter
0.046456 4.5° tilt calculated from Tx diameter

Reson Projector to Receiver

(from Reson diagram, entered in 
Reson Hardware configuration)

Waterline to Stbd 7125 RP

Port IMU to 
Port 7125

Waterline to Stbd 7125 RP

Port IMU RP 
to Port 7125 

RP

Top Port IMU 
to Waterline

(from waterline spreadsheet)

(Hypack vertical is positive down 
from waterline.)

(from calculations)

Port IMU to Port 7125 Fwd Port Ant to Port 7125 RP

Port IMU 
Plate to Port 

7125 

Port IMU RP to 
Port 7125 

Projector to Receiver 

(from POSMV V5 User 
Guide)

Top of IMU to 
center of IMU 

Plate

Antenna Phase 
Center to IMU 

Ref Pt

(x/y from Impastato, Z 
from 2013 drydock)*

(x/y from Impastato, Z from 
2013 drydock)

(from POS MV calculation 
tab)

Reson Projector to Receiver

Tx RP

(from Reson diagram)

Rx RP

(from Reson diagram and  
2013 drydock)

Hysweep Offsets

Port IMU to Port 7125 Fwd Port Ant to Port 7125

Port IMU to Port 7125 (MRU to 
Trans)

Fwd Port Ant to Port 7125 (Nav to 
Trans)

Offsets are derived from Impastato Centerline Survey (2010) and measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.



Offsets: Starboard 7125

Measurement
Coord. Sys. Caris Caris Reson Hypack

x 1.424 4.528 0.000 Stbd 1.424
y 0.380 -2.320 -0.437 Fwd 0.380
z 1.358 14.278 0.047 Vertical 3.789

TILTED 4.5 degrees up to stbd TILTED 4.5 degrees up to stbd
*Top of IMU is RP (Reference Pt)

Calculations

x 0.000 x 3.104 x 0.000 x 1.424

y 0.000 y -2.700 y 0.000 y 0.380
z 0.1356 z 12.920 z 0.000 z 1.358

(in CARIS) (in CARIS) (in Reson) (in CARIS)

x 1.424 x 1.424 x 0.000 x 0.000

y 0.380 y 0.380 y 0.437 y 0.000

z 1.222 z 1.358 z -0.047 z 2.431
(in CARIS) (in CARIS) (in Reson) (in Hypack)

x 1.424 x 4.528 x 0.000 x 1.424

y 0.380 y -2.320 y -0.437 y 0.380
z 1.358 z 14.278 z 0.047 z 3.789

(in CARIS) (in CARIS) (in Reson) (in Hypack)

*CALCULATION NOTES*
Z calc includes 0.015 m from base to RP 0.102 from Reson diagram - Rx width

Impastato X/Y measurement locations unknown 0.246 from 2013 drydock - Gap between Rx and Tx

0.28 from Reson diagram - Tx length

0.003656 4.5° tilt calculated from Tx diameter
0.046456 4.5° tilt calculated from Tx diameter

(from Reson diagram and  
2013 drydock)*

Reson Projector to Receiver Waterline to Stbd 7125 RP

Hysweep OffsetsReson Projector to Receiver 

(from Reson diagram, entered in 
Reson Hardware configuration)

Stbd IMU to 
Stbd 7125

Stbd IMU RP to 
Stbd 7125 

Stbd IMU to Stbd 7125 RP Fwd Stbd Ant to Stbd 7125 RP

Stbd IMU to Stbd 7125 Fwd Stbd Ant to Stbd 7125

IMU Plate to 
Stbd 7125 

Antenna Phase 
Center to IMU 

Ref Pt

Top of IMU 
to Center of 
IMU Plate

(from POSMV V5 User 
Guide)

Stbd IMU to Stbd 7125 (MRU to 
Trans)

Fwd Stbd Ant to Stbd 7125 (Nav to 
Trans)

Top Stbd 
IMU to 

Waterline

(from waterline spreadsheet)

(Hypack vertical is positive down from 
waterline.)

Waterline to Stbd 7125 RP

Stbd IMU RP 
to Stbd 7125 

RP

(x/y from Impastato, Z from 
2013 drydock)

Offsets are derived from Impastato Centerline Survey (2010) and measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.

(x/y from Impastato, Z 
from 2013 drydock)*

(from POS MV calculation 
tab)

(from calculations)

Reson Projector to Receiver

Tx RP

(from Reson diagram)

Rx RP



Offsets: Starboard 7111

Measurement

Coord. Sys. Caris Caris Reson Hypack

x 1.203 4.307 0.000 Stbd 1.203

y 11.608 8.908 -0.499 Fwd 11.608

z 0.977 13.897 -0.269 Vertical 3.408

*Top of IMU is RP (Reference Pt)

Calculations

x 0.000 x 3.104 x 0.000 x 1.203

y 0.000 y -2.700 y 0.000 y 11.608

z 0.1356 z 12.920 z 0.000 z 0.977
(in CARIS) (in CARIS) (in Reson) (in CARIS)

x 1.203 x 1.203 x 0.000 x 0.000

y 12.107 y 11.608 y 0.499 y 0.000

z 1.159 z 0.977 z 0.269 z 2.431
(in CARIS) (in CARIS) (in Reson) (in Hypack)

x 0.000

y -0.499

z -0.318
(in CARIS)

x 1.203 x 4.307 x 0.000 x 1.203

y 11.608 y 8.908 y -0.499 y 11.608

z 0.977 z 13.897 z -0.269 z 3.408
(in CARIS) (in CARIS) (in Reson) (in Hypack)

*CALCULATION NOTES*

1.203 from Impastato ‐ CL IMU to CL Plate 0.098 from Reson diagram - Tx diameter

11.77 from Impastato ‐ CL IMU to CL Plate

0.05341 from Reson diagram ‐ CL Plate to Mounting Bolt

0.434 from Reson diagram ‐ Mounting Bolt to aft Tx

0.65 from Reson diagram ‐ Tx overall length

0.125 from 2013 drydock ‐ Gap between Tx and Rx

0.0982 from Reson diagram ‐ Rx thickness

Sanity Check Physical measurement = 11.150 +/- 20 cm

calc measurement = 11.228

diff = -0.078

Reson Projector to Receiver

(from Reson diagram and 
2013 drydock)*

Waterline to 7111 RP

IMU RP to 7111 
Acoustic RP

(from calculations)(from Reson diagram)

Rx RP
Top Stbd IMU to 

Waterline

(from waterline spreadsheet)

Top of Stbd IMU to 7111 RP Fwd Stbd Ant RP to 7111 RP

IMU Plate to 
7111 Rx Face

(from POS MV calculation tab)

7111 Rx Face to 
7111 Acoustic 

RP

(from Reson diagram)

(x/y from Impastato, Reson 
diagram and 2013 drydock, z 

from 2013 drydock)*

(x/y from Impastato and Reson 
diagram, z from 2013 drydock)

(from POSMV V5 User Guide)

IMU to 7111 (MRU to Trans) Fwd Stbd Ant to 7111 (Nav to Trans) Hysweep Offsets

Antenna Phase 
Center to IMU 

RP

Top Stbd IMU to 
7111 RP

Top of IMU to 
Center of IMU 

Plate

Waterline to 7111 RP

(Hypack vertical is positive down 
from waterline.)

Reson Projector to Receiver 

(from Reson diagram, entered in 
Reson Hardware configuration)

Tx RP

Reson Projector to Receiver

Stbd IMU to 
7111 RP

Offsets are derived from Impastato Centerline Survey (2010) and measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.

Stbd IMU to 7111 Fwd Stbd Ant to 7111 RP



Offsets: Dual 7125 (HSX only)

Measurement
Coord. Sys. Caris Caris Caris Caris Hypack Hypack

x -13.490 1.424 -10.386 4.528 Stbd -13.490 Stbd 1.424
y 0.338 0.380 -2.362 -2.320 Fwd 0.338 Fwd 0.380
z 1.314 1.358 14.234 14.278 Vertical 3.745 Vertical 3.789

*Top of Stbd IMU is RP (Reference Pt) TILTED 4.5 degrees up to port TILTED 4.5 degrees up to stbd
Tilted up 4.5 degrees up on both sides

Calculations

x 0.000 x 0.000 x 3.104 x 3.104 x -13.490 x 1.424

y 0.000 y 0.000 y -2.700 y -2.700 y 0.338 y 0.380
z 0.1356 z 0.1356 z 12.920 z 12.920 z 1.314 z 1.358

(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in CARIS) (in CARIS)

x -12.246 x 1.424 x -13.490 x 1.424 x 0.000 x 0.000

y -0.024 y 0.380 y 0.338 y 0.380 y 0.000 y 0.000

z -0.035 z 1.222 z 1.314 z 1.358 z 2.431 z 2.431
(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

x -1.244
y 0.362

z 1.213
(in CARIS)

x -13.490 x 1.424 x -10.386 x 4.528 x -13.490 x 1.424

y 0.338 y 0.380 y -2.362 y -2.320 y 0.338 y 0.380
z 1.314 z 1.358 z 14.234 z 14.278 z 3.745 z 3.789

(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

Note: For dual acquisition 7125, the HSX file contains data from both 7125s but only POSMV data from the stbd POSMV.  The port 7125 is swath 1 (beams 1-512) and the stbd 7125 is swath 2 (beams 513 to 1024).  

Fwd Stbd Ant to Stbd 7125 RPStbd IMU to Port 7125 RP Fwd Stbd Ant to Port 7125 RP

(x/y from Impastato, Z from 
2013 drydock)

Stbd IMU to Stbd 7125 RP

(x/y from Impastato, Z from 
2013 drydock)

(x/y from Impastato, Z from 2013 
Drydock)

Port IMU Plate 
to Port 7125

(x/y from Impastato, Z from  2013 
Drydock)

(x/y from Impastato, Z from  2013 
Drydock)

(from POS MV calculation 
tab)

Fwd Stbd Ant 
to Stbd IMU RP

top of IMU 
toCenter of 

Stbd IMU Plate

(from POSMV V5 User Guide)

Stbd IMU Plate 
to Port IMU 

Plate 

Stbd IMU RP to 
Port 7125 

Fwd Stbd Ant 
to Stbd IMU RP

(from POS MV calculation 
tab)

Stbd IMU RP to 
Stbd 7125 

Stbd 7125 Hysweep Offsets

Stbd IMU to 
Stbd 7125

Waterline to Stbd 7125 RP

Top Stbd 
IMU to Stbd 

7125 RP

Top Stbd 
IMU to 

Waterline

(from calculcations)

Offsets are derived from Impastato Centerline Survey (2010) and measurements by FH personnel made April 2012 after installation of new lever arm mounts and April 2013 during drydock.

top of IMU to 
Center of IMU 

Plate 

(from POSMV V5 User Guide)

IMU Plate to 
Stbd 7125 

Fwd Stbd Ant to Stbd 7125 (Nav to 
Trans)

Fwd Stbd Ant to Stbd 7125

Stbd IMU to Port 7125 (MRU to Trans) -
Swath 1

(from waterline spreadsheet)

Waterline to Stbd 7125 RP

Top Stbd 
IMU to Port 

7125 RP

Top Stbd 
IMU to 

Waterline

(from waterline spreadsheet)

Waterline to Stbd 7125 RP

(from calculcations)

Stbd  IMU to Stbd 7125 (MRU to 
Trans) - Swath 2

Stbd IMU to Stbd 7125Stbd IMU to Port 7125 Fwd Stbd Ant to Port 7125 Waterline to Stbd 7125 RP

(Hypack vertical is positive down 
from waterline.)

Stbd IMU to 
Port 7125

Fwd Stbd Ant to Port 7125 (Nav to 
Trans) Port 7125 Hysweep Offsets



Offsets: ODOM Single Beam

Measurement

Coord. Sys. Caris Caris Caris Caris Hypack Hypack

x ‐0.455 ‐12.701 2.649 ‐9.597 Stbd -0.455 Stbd -12.701

y 4.620 4.620 1.920 1.920 Fwd 4.620 Fwd 4.620

z 1.383 1.381 14.303 14.301 Vertical 3.835 Vertical 3.861

(in CARIS) (in CARIS) TILTED 4.5 degrees up to port TILTED 4.5 degrees up to stbd

Calculations

x 0.000 x 0.000 x 3.104 x 3.104 x -0.455 x -12.701

y 0.000 y 0.000 y -2.700 y -2.700 y 4.620 y 4.620

z 0.1356 z 0.1356 z 12.920 z 12.920 z 1.383 z 1.381
(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in CARIS) (in CARIS)

x -0.455 x -12.701 x -0.455 x -12.701 x 0.000 x 0.000

y 4.620 y 4.620 y 4.620 y 4.620 y 0.000 y 0.000

z 1.247 z 1.245 z 1.383 z 1.381 z 2.431 z 2.431
(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

x -0.455 x -12.701 x 2.649 x -9.597 x -0.455 x -12.701

y 4.620 y 4.620 y 1.920 y 1.920 y 4.620 y 4.620

z 1.383 z 1.381 z 14.303 z 14.301 z 3.835 z 3.861
(in CARIS) (in CARIS) (in CARIS) (in CARIS) (in Hypack) (in Hypack)

Fwd Stbd Ant to Port 7125 RP Fwd Stbd Ant to Stbd 7125 RP

Fwd Stbd Ant to Stbd SB Fwd Stbd Ant to Port SB

Fwd Stbd 
Ant to Stbd 

IMU RP

Fwd Stbd 
Ant to Stbd 

IMU RP

(from POS MV calculation 
tab)

(from POS MV calculation 
tab)

Stbd IMU to 
Stbd SB 

Stbd IMU to 
Port SB

Fwd Stbd Ant to Stbd SB Fwd Stbd Ant to Port SB

(x/y from Impastato, Z from 
2013 drydock)

(x/y from Impastato, Z from 
2013 drydock)

Stbd IMU to Port SB

top of IMU 
to Center of 

IMU Plate

(from POSMV V5 User 
Guide)

Stbd IMU 
Plate to Port 

SB

(x/y from Impastato, Z from 
2013 drydock)*

Stbd IMU to Stbd SB

top of IMU 
to Center of 

IMU Plate

(from POSMV V5 User 
Guide)

Stbd IMU 
Plate to 
Stbd SB 

(x/y from Impastato, Z from 
2013 drydock)*

Stbd IMU to Stbd SB

Stbd IMU to Stbd SB Stbd IMU to Port SB

(x/y from Impastato, Z from 
2013 drydock)

(x/y from Impastato, Z from 
2013 drydock)

Stbd IMU to Stbd SB

Port 7125 Hysweep Offsets Stbd 7125 Hysweep Offsets

Stbd IMU to 
Stbd SB

Stbd IMU to 
Port SB

(Hypack vertical is positive down 
from waterline.)

Waterline to Stbd 7125 RP

Waterline to Port SB RP

Stbd IMU RP 
to Port SB 

RP

(from calculations)

Top Stbd 
IMU to 

Waterline

(from waterline 
spreadsheet)

Waterline to Stbd 7125 RP

Waterline to Stbd SB RP

Stbd IMU RP 
to Stbd SB 

RP

(from calculations)

Top Stbd 
IMU to 

Waterline

(from waterline 
spreadsheet)



Offsets: Klein 5000
Measurement

Coord. Sys. Caris

x 7.161
y ‐26.032
z ‐9.347

(in CARIS)

Port IMU to TowPoint



2013 Elipsoid Referenced Dynamic Draft Results
Canards at Zero 2013_177_S250P 3rd order

Speed 
(m/s)

Port 3rd 
Order

Stbd 3rd 
Order

Port 4th 
Order

Stbd 4th 
Order

Standard

0.0 0 0 0 0 0.00
0.5 ‐0.11 ‐0.11 0.01 0.05 0.03
1.0 ‐0.19 ‐0.19 ‐0.02 0.03 0.01
1.5 ‐0.24 ‐0.24 ‐0.07 ‐0.02 ‐0.05
2.0 ‐0.27 ‐0.27 ‐0.13 ‐0.08 ‐0.11
2.5 ‐0.28 ‐0.27 ‐0.17 ‐0.13 ‐0.15
3.0 ‐0.26 ‐0.26 ‐0.19 ‐0.16 ‐0.18
3.5 ‐0.23 ‐0.24 ‐0.18 ‐0.16 ‐0.17
4.0 ‐0.19 ‐0.2 ‐0.14 ‐0.12 ‐0.13
4.5 ‐0.14 ‐0.15 ‐0.07 ‐0.06 ‐0.07
5.0 ‐0.08 ‐0.09 0 0.02 0.01
5.5 ‐0.02 ‐0.03 0.08 0.1 0.09
6.0 0.05 0.03 0.15 0.16 0.16
6.5 0.11 0.08 0.18 0.17 0.18
7.0 0.17 0.14 0.14 0.11

*********Used 4th order standard values

 

2013_177_S250S 3rd order
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Date: NA Personnel: NA
DESIGN DRAFT OF 3.85 METERS
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.85
Fwd 

Inboard
3.85

Fwd 
Inboard

3.85
Fwd 

Outboard
3.85

Aft 
Outboard

3.85 Aft Inboard 3.85
Aft 

Inboard
3.85

Aft 
Outboard

3.85

Port Ave 3.85 Stbd Ave 3.85

x x

y y

z -0.1356 z -0.1356

x x x x

y y y y
z -3.313 z -3.308 z -3.426 z -3.428

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.306 z -3.305 z -3.344 z -3.358

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From 2013 Drydock Ave -3.308 From 2013 Drydock Ave -3.389

x x 4.6 x x

y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z 0.750 z 0.750 z 0.750 z 0.750

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.750 Calculated from draft mark 4.6 to draft readings Ave 0.750

x x x x

y y y y
z -2.427 z -2.422 z -2.540 z -2.542

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x

y y y y
z -2.420 z -2.419 z -2.458 z -2.472

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.694 Ave -2.639

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.4274

Fwd 
Inboard

2.4224 -1
Fwd 

Inboard
2.5404

Fwd 
Outboard

2.5424 -1

Aft 
Outboard

2.4204
Fwd 

Inboard
2.4194

Fwd 
Inboard

2.4584
Aft 

Outboard
2.4724

Port Ave 2.4224 Stbd Ave 2.5034

x x
Waterline y Waterline y PORT, STBD Ave
to IMU  (m) z 2.422 to IMU  (m) z 2.503 2.463

(In CARIS) (In CARIS)

Waterline to IMU Offset

Center of IMU 
Plate  to top of 

IMU

Center of IMU 
Plate  to top of 

IMU

IMU Plate to Fwd 
Outboard 4.6 

Draft Mark

IMU Plate to Fwd 
Inboard 4.6 Draft 

Mark

IMU plate to Fwd 
Inboard 4.6 Draft 

Mark

IMU plate to Fwd 
Outboard 4.6 

Draft Mark

IMU Plate to Aft 
Outboard 4.6 

Draft Mark

IMU Plate to Aft 
Inboard 4.6 Draft 

Mark

IMU plate to Aft 
Inboard 4.6 Draft 

Mark

IMU plate to Aft 
Outboard 4.6 

Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU



Date: 6/14/2013 Personnel: Adler, Reed, Moehl
Location: MOC-A Port ERLL/WRLL
PORT PONTOON Draft Readings STBD PONTOON Draft Readings

Fwd 
Outboard

3.66
Fwd 

Inboard
3.65

Port Fwd 
Outboard

3.75
Stbd Fwd 
Outboard

3.59

Aft 
Outboard

3.92 Aft Inboard 3.91
Port Aft 

Outboard
3.85

Stbd Aft 
Outboard

3.78

Port Ave 3.785 Stbd Ave 3.743

x x
y y

z -0.1675 z -0.1675

x x x x
y y y y
z -3.313 z -3.308 z -3.313 z -3.426

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -3.306 z -3.305 z -3.306 z -3.344

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
From 2013 Drydock Ave -3.308 From 2013 Drydock Ave -3.347

x x 4.6 x x

y y y y
z 0.940 z 0.950 z 0.850 z 1.010

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z 0.680 z 0.690 z 0.750 z 0.820

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Calculated from draft mark 4.6 to draft readings Ave 0.815 Calculated from draft mark 4.6 to draft readings Ave 0.858

x x x x
y y y y
z -2.206 z -2.191 z -2.296 z -2.249

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
x x x x
y y y y
z -2.459 z -2.448 z -2.389 z -2.357

(in CARIS) (in CARIS) (in CARIS) (in CARIS)
Ave -2.661 Ave -2.490

PORT Waterline to Port IMU STBD Waterline to Stbd IMU
Fwd 

Outboard
2.2055

Fwd 
Inboard

2.1905 -1
Fwd 

Inboard
2.2955

Fwd 
Outboard

2.2485 -1

Aft 
Outboard

2.4585
Fwd 

Inboard
2.4475

Fwd 
Inboard

2.3885
Aft 

Outboard
2.3565

Port Ave 2.3255 Stbd Ave 2.32225

x x
Waterline y Waterline y
to IMU  (m) z 2.326 to IMU  (m) z 2.322

(In CARIS) (In CARIS)

Center of IMU 
Plate  to top of 

IMU

Center of IMU 
Plate  to top of 

IMU

IMU Plate to Fwd 
Outboard 4.6 

Draft Mark

IMU Plate to Fwd 
Inboard 4.6 Draft 

Mark

IMU plate to Fwd 
Inboard 4.6 Draft 

Mark

IMU plate to Fwd 
Outboard 4.6 

Draft Mark

IMU Plate to Aft 
Outboard 4.6 M 

Draft Mark

IMU Plate to Aft 
Inboard 4.6 Draft 

Mark

IMU plate to Aft 
Inboard 4.6 Draft 

Mark

IMU plate to Aft 
Outboard 4.6 

Draft Mark

Fwd Outboard 
Draft Mark to 

Waterline

Fwd Inboard Draft 
Mark to Waterline

Fwd Inboard 
Draft Mark to 

Waterline

Fwd Outboard 
Draft Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

Aft Inboard Draft 
Mark to Waterline

Aft Inboard Draft 
Mark to 

Waterline

Aft Outboard 
Draft Mark to 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Fwd 
Inboard Waterline

IMU to Fwd 
Inboard 

Waterline

IMU to Fwd 
Outboard 
Waterline

IMU to Aft 
Outboard 
Waterline

IMU to Aft Inboard 
Waterline

IMU to Aft 
Inboard 

Waterline

IMU to Aft 
Outboard 
Waterline

Port Waterline to Port IMU Stbd Waterline to Stbd IMU



Appendix II 
 
 
Echosounder Reports 
 



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

7/30/2013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

0
180

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

_222918

XTF Line Filename
_221500

XTF Line Filename
Use roll lines

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

18215011048

BOT_0000-0001

S250

211 Approaches to Chesapeake (H12504 obstruction)

Adler, Reed, Mortimer, Moehl

Starboard 7125 400kHz Starboard Pontoon



SV Cast # Heading Speed (kts) Remarks
0

180_222400

XTF Line Filename
_222004



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

225
045

XTF Line Filename
_223428
_224200



Processing Log

7/31/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

212 Moehl

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.23 0.00 0.50
0.00 -0.12 0.00 0.68

0.00 -0.19 0.01 0.51
0.00 0.18 0.03 0.22

Resulting HVF File Name

MRU Align StdDev gyro 0.05 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

Averages
Standard Deviation

FINAL VALUES

Final Values based on

Reed

Kist

PATCH TEST RESULTS/CORRECTORS

Moehl



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

10/242013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

XTF Line Filename

XTF Line Filename
Use roll lines

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

18215011048

S250

297 Approaches to New York H12627

Adler, Reed, Moehl, Kist, Faulkes

Roll Lines Only - troubleshooting offset in NY

Starboard 7125 400kHz Starboard Pontoon



SV Cast # Heading Speed (kts) RemarksXTF Line Filename



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

180 7.0
0 7.0

XTF Line Filename
_211113
_211402



Processing Log

10/24/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

297 Reed

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.23 #DIV/0! 0.50
0.00 -0.12 0.10 0.68

0.00 -0.19 0.10 0.51
0.00 0.18 0.01 0.22

Resulting HVF File Name

MRU Align StdDev gyro 0.05 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

Averages
Standard Deviation

FINAL VALUES

Final Values based on

Reed

Kist

PATCH TEST RESULTS/CORRECTORS

Moehl



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

6/27/2013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

15:50 9.2
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

0 6.0
180 6.0

0 9.0
180 9.0

065
245
245

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

Use roll lines

20130724_010022

XTF Line Filename

2013_178_S250S.000

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

BOT_0002.svp 37:13:50 -076:04:40

20130627_133431

S250

Adler, Reed, Mortimer, Moehl

Starboard Pontoon

178

Starboard 7125 400kHz

18215011048

Cape Charles City Obstruction

20130724_001158
20130724_002125

20130627_134245

20130627_131302
20130627_132342



SV Cast # Heading Speed (kts) Remarks
0 7.0

180 7.0

065
24520130724_014536

20130627_151917

20130724_010921

20130627_150946
XTF Line Filename



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

045 5.5
225 5.5
045 9.0
225 9.0

225
045

20130724_010022

XTF Line Filename

201301724_001158

20130627_160025
20130627_160857
20130627_162943
20130627_163520



Processing Log

6/28/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

GPS Tides applied, patch test to the ellipsoid

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Data converted --> HDCS_Data in CARIS

Mortimer, Reed, Adler, Moehl179

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.15 -4.41 0.35
0.00 0.36 -4.46 0.59
0.00 -0.02 -4.45 0.66
0.00 0.29 -4.35 0.37

0.00 -0.28 -0.05 -0.15
0.00 0.13 0.09 0.15

Resulting HVF File Name

MRU Align StdDev gyro 0.03 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

PATCH TEST RESULTS/CORRECTORS

Moehl
Adler

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Reed
Mortimer



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

7/31/2013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

1829 70
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1917 72
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

072/34/06 W

2013_212_S250S

39/40/04 N 072/33/51 W

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

S250

Mohel, Reed, Alder, Kist

STBD Pontoon

212

Starboard 7125 200kHz

18215011048

Hudson Canyon

BOT_0002

BOT_0003

39/40/17 N

SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

300 7.5
300 7.5
120 7.5

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

XTF Line Filename

XTF Line Filename
_182114
_182204
_182822

had roll stab on / delete line



SV Cast # Heading Speed (kts) Remarks
300 7.0
120 7.0

_183556
XTF Line Filename

_184244



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

use pitch lines
XTF Line Filename



Processing Log

7/31/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Reed, Adler, Moehl, Kist212

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.02 0.03 0.70
0.00 0.06 0.05 0.84

0.07 0.03 0.88

0.00 0.05 0.01 0.62
0.00 0.07 0.05 0.36

Resulting HVF File Name

MRU Align StdDev gyro 0.08 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.01 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

PATCH TEST RESULTS/CORRECTORS

Moehl
Reed

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Adler

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

6/27/2013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

0
180

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

_220438

XTF Line Filename
_214813

XTF Line Filename
Use roll lines

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

18210412051

S250

178 Sheet H12504

Adler, Reed, Mortimer, Moehl

Port 7125 400kHz Port Pontoon



SV Cast # Heading Speed (kts) Remarks
0

180_215224

XTF Line Filename
_215658



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

225
045

XTF Line Filename
_223428
_224200



Processing Log

7/31/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

212 Moehl

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.39 -0.03 0.40
0.00 -0.13 -0.03 -0.09
0.00 -0.51 -0.01 0.22
0.00 -0.54 -0.03 -0.18

0.00 -0.39 -0.02 0.09
0.00 0.22 0.03 0.29

Resulting HVF File Name

MRU Align StdDev gyro 0.06 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

Averages
Standard Deviation

FINAL VALUES

Final Values based on

Reed
Adler
Kist

PATCH TEST RESULTS/CORRECTORS

Moehl



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

10/24/2013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

XTF Line Filename

XTF Line Filename
Use roll lines

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

18210412051

S250

297 Sheet H12627

Adler, Reed, Moehl, Kist, Faulkes

Roll Only

Port 7125 400kHz Port Pontoon



SV Cast # Heading Speed (kts) RemarksXTF Line Filename



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

180 7.0
0 7.0

XTF Line Filename
_211114
_213926



Processing Log

10/24/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Compute correctors in this order
1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Do not enter/apply correctors until all evaluations are complete and analyzed.

297 Reed

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 -0.39 #DIV/0! 0.40
0.00 -0.13 -0.08 -0.09
0.00 -0.51 -0.08 0.22
0.00 -0.54 #DIV/0! -0.18

0.00 -0.39 -0.08 0.09
0.00 0.22 0.00 0.29

Resulting HVF File Name

MRU Align StdDev gyro 0.06 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

Averages
Standard Deviation

FINAL VALUES

Final Values based on

Reed
Adler
Kist

PATCH TEST RESULTS/CORRECTORS

Moehl



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

6/27/2013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

15:50 9.2
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

0 6.0
180 6.0

0 9.0
180 9.0

234
055

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

-076:04:40

2013_178_S250P.000

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

20130724_011804

S250

Adler, Reed, Mortimer, Moehl

Port Pontoon

178

Port 7125 400kHz

18210412051

20130724_012552

XTF Line Filename
20130627_131254

Use roll lines

Cape Charles City Obstruction

BOT_0002.svp

20130724_004951

37:13:50

20130627_132342
20130627_133431
20130627_134245

used (dtm)
used (dtm)



SV Cast # Heading Speed (kts) Remarks
0 7.0

180 7.0

056
236
235
056
235

20130627_152811
XTF Line Filename

20130724_002125

20130724_013533
used (dtm)

20130724_010024

20130627_154601

20130724_001154

used (dtm)
20130724_012552



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

045 5.5
225 5.5
045 9.0
225 9.0

235
055

20130724_010024

20130627_160024
20130627_160856
20130627_162944
20130627_163519

used (dtm)

XTF Line Filename

20130724_012552 used (dtm)



Processing Log

6/28/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

GPS Tides applied, patch test to the ellipsoid

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias

Mortimer, Reed, Adler, Moehl179

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.52 -0.05 -0.37
0.00 0.28 0.42 -0.71
0.00 0.49 -0.03 -0.25
0.00 0.21 0.10 -0.07

0.00 0.37 0.11 -0.35
0.00 0.18 0.20 0.45

Resulting HVF File Name

MRU Align StdDev gyro 0.10 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:

PATCH TEST RESULTS/CORRECTORS

Moehl
Adler

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Reed
Kist



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

7/31/2013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

1829 70
SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

1917 72
SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

S250

Mohel, Reed, Alder, Kist

Port Pontoon

212

Port 7125 200kHz

18210412051

Hudson Canyon

BOT_0002

BOT_0003

39/40/17 N 072/34/06 W

2013_212_S250P

39/40/04 N 072/33/51 W

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

300 7.0
120 7.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

_190059
W/ watercolumn data (25 samples / beam)
W/ watercolumn data (100 samples / beam)

XTF Line Filename
_185301

XTF Line Filename



SV Cast # Heading Speed (kts) Remarks
300 7.0
120 7.0_191605

_190929
XTF Line Filename



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) RemarksXTF Line Filename

use pitch lines



Processing Log

Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)
0.00 0.13 0.04 0.65
0.00 0.25 -0.07 -0.24
0.00 0.31 -0.13 -0.53
0.00 -0.04 0.15 -0.17

0.00 0.16 0.00 -0.07
0.00 0.18 0.11 0.47

Resulting HVF File Name

MRU Align StdDev gyro 0.10 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.02 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

PATCH TEST RESULTS/CORRECTORS

Moehl
Reed

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Adler
Kist

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:



Ferdinand R. Hassler

Multibeam Echosounder Calibration
Vessel

7/31/2013
Date Dn Local Area

Calibrating Hydrographer(s)

Comments

MBES System MBES System Location Date of most recent EED/Factory Check

Sonar Serial Number Processing Unit Serial Number

TrueHeave filename

SV Cast #1 filename UTC Time Lat Lon Depth Ext. Depth

SV Cast #2 filename UTC Time Lat Lon Depth Ext. Depth

DGPS = Moriches

NAV TIME LATENCY
SV Cast # Heading Speed (kts) Remarks

S250

Adler, Moehl, Kist, Reed

Stbd Pontoon

212

7111

Hudson Canyon

Bot_0001 -> Bot_

2013_212_S250S.000->?

XTF Line Filename

view parallel to track, one line with induced roll (outerbeam) or same lines bounded slope (nadir) 
[same direction, different speed]

SV Cast # Heading Speed (kts) Remarks

PITCH view parallel to track, same line (at nadir) [opposite direction, same speed]
SV Cast # Heading Speed (kts) Remarks

300 7.0
120 7.0
300 7.0

HEADING/YAW view parallel to track, offset lines (outerbeams) [opposite direction, same speed]

_172910
_173745

took long break for training after line completed
XTF Line Filename
_161200

XTF Line Filename



SV Cast # Heading Speed (kts) Remarks
235 7.0
050 7.0
300 7.0
120 7.0_181337

_175805
_180552

significant crab observed
_175101 significant crab observed
XTF Line Filename



ROLL view across track, same line [opposite direction, same speed]
SV Cast # Heading Speed (kts) RemarksXTF Line Filename

use pitch lines



Processing Log

7/31/2013
Date Dn Personnel

TrueHeave applied

SVP applied

Tide applied

Zone file

Lines merged

Data cleaned to remove gross fliers

Do not enter/apply correctors until all evaluations are complete and analyzed.

Compute correctors in this order

Data converted --> HDCS_Data in CARIS

Mohel, Reed, Alder, Kist212

1. Precise Timing                               2. Pitch bias                              3. Heading bias                              4. Roll bias



Evaluators Latency (sec) Pitch (deg) Roll (deg) Yaw (deg)

0.00 -0.89 0.00 1.61
-0.82 -0.06 1.03

0.00 -0.88 -0.02 0.90
#DIV/0! 0.27 0.05 0.59

Resulting HVF File Name

MRU Align StdDev gyro 0.13 Value from standard deviation of Heading offset values
MRU Align StdDev Roll/Pitch 0.03 Value from averaged standard deviations of pitch and roll offset values

NARRATIVE

PATCH TEST RESULTS/CORRECTORS

Reed

Final Values based on

Averages
Standard Deviation

FINAL VALUES

Adler

HVF Hydrographic Vessel File created or updated with current offsets

Name: Date:



Appendix III 
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During the period of May16th to May 18th, 2011 two POSMV systems were commissioned 
aboard NOAA vessel Ferdinand Hassler. The following is a summary of the events and final 
observations.  
 
Chronology: 
May 16th-  

Travel from Houston TX to New Orleans LA. Overnight in Gulfport MS with the 
intention of meeting the ship in the morning to conduct dockside testing in the 
morning before the ship sets sail in the afternoon. Informed by Steve Laverty 
there has been a change in plan and the CO wants to depart the dock at 0900 
tomorrow instead.  
 

May 17th-  
 Arrive ship 0730. Brief review of POSMV installation with Briana Welton followed 

by cursory inspection.  Both POSMV systems are up and running with no errors. 
Collected a set of dockside POSMV data from both systems for processing in 
POSPAC later today. Plan is to meet at the NOAA facility in Pascagoula at 0630 
and transit out to ship in small boat.  

 
May 18th-  0630- Depart Pascagoula for Ferdinand Hassler. Upon arrival commenced 

system inspection and diagnostics. No faults found. Conducted two GAMS 
calibrations on both POSMV systems and  completed system acceptance testing.  

 
   
Calibration and testing results: 

1. The GAMS calibration was completed on May 18th and checked against the calculations 
derived from the survey report. Further comparisons are required but it appears that the 
survey calculations differ somewhat from the GAMS measured values.  

Notes: 
  As a result of post processing the data set collected during commissioning, it was 
discovered that the POSMV IMU’s were actually reversed at the back of the POSMV PCS units. 
Because of the symmetry in the two systems, these errors were not immediately obvious during 
the trials; however the lever arm errors were apparent in the data set.  After physically changing 
the IMU inputs the processed calibration data was now reasonable when compared to the 
measured survey results. A new GAMS calibration was performed by the NOAA personnel after 
the IMU cables were returned to the correct orientation and the information below is based upon 
the correct orientation.  

Bruce A. Francis Applanix Corporation. 
17461 Village Green Drive 
Houston TX 77040 
USA 
Tel: (713) 896-9900 
Fax: (713) 896-9919 
bfrancis@applanix.com 
http://www.applanix.com 

 
Company: Oak Management 

Attention 
of: 

Steve Laverty   

Email:   steve.laverty@oakmanagement.com 

From: Bruce A. Francis 

Date: 18 May, 2011  

Ref.: POSMV Installation aboard  

Ferdinand Hassler-SWATH 
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Recommendations:  
 
While the large separation between the GPS antennas across decks will improve heading 
accuracy, there is a possibility that flexure in the ship will cause poor GAMS performance as the 
baseline vectors may become unstable. We were unable to fully test this configuration in a calm 
sea but if this turns out to be the case after the ship experiences a modest increase in sea state, 
the solution might be to extend the separation between the antennas on the individual mounts 
and switch the antenna input to the POS from cross decks to using the pairs from each side to 
their corresponding POS unit. The minimum separation should be 1 meter whereas now the 
distance is only about 0.6m and slightly too short to expect normal GAMS performance.  
 
 
 
 

 
Submitted By: 
Bruce A. Francis 
Customer Support Engineer 
Marine Products 
713-896-9900 
bfrancis@applanix.com 
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Vessel Name Ferdinand R. Hassler 
Year Built 2010 
POSMV Location Port Side 
PCS Serial Number 3187 

IMU Serial Number 
Top Hat 

 
804 (Cable S/N 105) 

Hardware Version 3.3-7 

Firmware Version 5.03 

POS IP Address 
Subnet Mask 

129.100.2.231 
255.255.0.0 

POS PC Address 
Subnet Mask 

129.100.2.234 
255.255.255.0 

Survey Software Hypack 11.0.8.0 
Multibeam System Reson 7125 

 

 
Port System Lever Arms: (Units are in Meters) 
Point X Axis Y Axis Z Axis Notes 
Reference point 0.0 0.0 0.0 PORT IMU 
Ref to IMU 0.0 0.0 0.0 PORT IMU 
Ref to Primary GPS 1.395 1.05 -13.084 Port Aft antenna 
Ref to Secondary GPS 1.418 9.188 -13.080 Strb Aft antenna  
Ref to AUX GPS N/A N/A N/A Not surveyed 
Ref to Vessel 0.0 0.0 0.0 POS NMEA, message point 

of validity at target on IMU. 
IMU frame w.r.t Ref 
frame 

0.0 0.0 0.0 Rotation of IMU frame in 
comparison to ships frame.  

Ref to Heave (COR) 0.0 0.0 0.0 Center of gravity (rotation) 
Information not available.  

Ref to Sensor 1 0.0 0.0 0.0 Point of validity of HPR 
+Posn-Valid at IMU 

Ref to Sensor 2 0.0 0.0 0.0 Point of validity-HPR +Posn-
Valid at IMU 
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General System information: 
 
Options included- RTK (RTK-0); True Heave (THV-0); (DPW-0) Password protection 
Disabled 
 
Port POSMV 

 
 
 
 
Basic installation geometry: 
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POSRT Data Extraction Utility [Jun 15 2011] 
Copyright (c) 2008-2011 Applanix Corporation.  All rights reserved. 
Date : 07/25/11    Time : 15:12:36 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
First POS file      : E:\Clients config, IP, & test results\NOAA\NOAA 
Swath\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Port_A_GAMS.000 
Last POS file       : E:\Clients config, IP, & test results\NOAA\NOAA 
Swath\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Port_A_GAMS.000 
Output path         : C:\Documents and Settings\bfrancis\My Documents\POSPac 
MMS\Unnamed(1)\Swath Port IMU\Extract 
Output kernel       : Swath Port IMU 
Start time          : 0.000 
End time            : 999999.000 
VNAV output modulus : 1 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307750.275 : The First Group 99: Versions & Statistics 
   System Version: 
     Product-Model: MV-320; Version: VER4; Serial Number: S/N3187; 
     Hardware Version: HW3.3-7; 
     Software Release Version-Date: SW05.03-Mar10/10; 
     ICD release version: ICD04.02; 
     Operating System Version: OS425B14; 
     IMU Type: IMU2; Primary GPS Type: PGPS13; Secondary GPS Type: SGPS13; 
     Option mnemonic-Expiry Time: DMI0; 
     Option mnemonic-Expiry Time: GIM0; 
     Option mnemonic-Expiry Time: RTK-0; 
     Option mnemonic-Expiry Time: THV-0; 
     Option mnemonic-Expiry Time: DPW-0; 
   Primary GPS Version: BD950     SN:4814A14457, v.00232, channels:24; 
   Secondary GPS Version: BD950     SN:4814A14447, v.00232, channels:24; 
   Total Hours          :    561.4; Number of Runs:     53 
   Average Length of Run:   10.6; Longest Run:  126.2; Current Run:   12.1; 
-------------------------------------------------------------------------------- 
307750.275 : Diffcorr2 time1 gap: start 0.0, end 307750.2749 
307750.280 : IMU type: IMU2  Data rate = 200 Hz 
307750.280 : Extracting Group 4 : Time-tag data 
307750.290 : SNV status changed to 0  (Full Nav) 
307751.070 : Primary GNSS receiver type is GNSS13. 
307751.090 : Secondary GNSS receiver type is GNSS13. 
307755.275 : GenB( 9):  GAMS solution in use CLEARED. 
307756.275 : GenB( 9):  GAMS solution in use SET. 
307758.275 : GenB( 9):  GAMS solution in use CLEARED. 
-------------------------------------------------------------------------------- 
307759.275 : Message 50: Transition to NAVIGATE mode. 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 37: Base 1 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: NAD83  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 38: Base 2 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: WGS84  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 20: General parameters 
   Time and distance tag types:          2  1 
   Autostart selection:                   ENABLED 
   Reference-IMU lever arm:              -0.008  -0.031  0.130 
   Reference-primary GPS lever arm:      1.395  1.050  -13.084 
   Reference-auxiliary 1 GPS lever arm:  0.000  0.000  0.000 
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   Reference-auxiliary 2 GPS lever arm:  0.000  0.000  0.000 
   Reference-IMU mounting angles:        0.000  0.000  0.000 
   Reference-vehicle mounting angles:    0.000  0.000  0.000 
   Multipath environment:                 LOW 
-------------------------------------------------------------------------------- 
 
-------------------------------------------------------------------------------- 
307759.275 : Message 22: Aiding sensor install parameters 
   DMI scale factor:                    0.00 
   Reference-DMI lever arm:             0.00    0.00    0.00 
   DVS scale factor correction:         1.00 
   Reference-DVS lever arm:             0.00    0.00    0.00 
   Reference-DVS attitude:              0.00    0.00    0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 24: User accuracy parameters 
   User position accuracy:       2.00 
   User velocity accuracy:       0.50 
   User attitude accuracy:       0.05 
   User heading accuracy:        0.05 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 106: Heave ratios 
   Heave Bandwidth (sec):  12.000 
   Heave Damping Ratio:  0.707 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 120: Heave and sensor 1&2 install parameters 
   Reference->Sensor1 alignment angles (R,P,Y) in degrees:  0.00  0.00  0.00 
   Reference->Sensor2 alignment angles (R,P,Y) in degrees:  0.00  0.00  0.00 
   Reference->Sensor1 lever arm in meters:                  0.00  0.00  0.00 
   Reference->Sensor2 lever arm in meters:                  0.00  0.00  0.00 
   Reference->Center of Rotation in meters:                    0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 121: Vessel Installation Parameters 
   Reference-Vessel in meters:                             0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 32: PCS IP address 
   IP Address (Network part 1): 129 
   IP Address (Network part 2): 100 
   IP Address (Host part 1):    1 
   IP Address (Host part 2):    232 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 56: General data 
   Initial status:     COARSE_LEVEL 
   Initial position:   30.339734242 -88.576108929 -24.927 
   Initial distance:   0.00 
   Initial attitude:   0.000 0.000 0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307759.275 : Message 21: GAMS install parameters 
   A-B antenna separation:        8.112 
   A-B baseline vector:           -0.060 8.112 0.021 
   Heading error for calibration: 0.50 
   A-B azimuth correction:        0.000 
-------------------------------------------------------------------------------- 
Available subsystems                  :  IMU 
                                      :  Primary GNSS 
                                      :  Secondary GNSS 
                                      :  Differential Corrections 
Vehicle to reference alignment angles :  0.000  0.000  0.000 
Multipath setting                     :  LOW 
Reference to IMU lever arm            : -0.008 -0.031  0.130 
Reference to IMU alignment angles     :  0.000  0.000  0.000 
Reference to primary GNSS lever arm   :  1.395  1.050 -13.084 
GAMS antenna separation               :  8.104 
GAMS baseline vector                  :  0.152  8.103 -0.004 
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GAMS heading calibration threshold    :  0.500 
GAMS heading correction               :  0.000 
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Observed GAMS values derived from the field calibration: 
 
Port GAMS Cal #1 
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Primary GPS data observed from internal Trimble BD950 receivers. 

 
 
 
 
 
Secondary embedded GPS data: 
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Com port #1 settings as installed: DGPS input from Trimble SPS Receiver. 

 
 
Com port #2 settings as installed 

 
 
Com port #3 settings as installed:  
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Com port #4 settings as installed:  
 

 
 
 
Com port #5 settings as installed 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Heave data plot: 
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The heave plot above shows the relationship between the Real-time (RT) heave and the True (or 
delayed TH) heave measurements. The green line relates to quality control (QC) and represents 
the difference between the two values. When the delta between the RT and TH exceeds 5cm or 
5% of total heave (pink line) then the radio light on the main controller screen will turn from green 
to red but does not affect the real-time heave data being collected. Quite often this occurs after 
the vessel makes a turn or an abrupt change in speed and is not necessarily cause for alarm.  
The heave filter has a 105 second buffer so the event which may have caused the impulse 
happened in the past.  A red light merely calls the users attention to the difference and may also 
suggest that the filter settings need to be refined if the QC value is continually out of bounds.   
 
Note: The TrueHeave data filter is delayed about 3 minutes from the TH value. Also, Group 111 & 
113 must be enabled in the Ethernet Real-time logging page.  In addition, this filter should be 
adjusted as required for changes in the local swell conditions.   
Heave Settings valid for both POSMV systems.  
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The main controller screens below shows normal POSMV operation. POS Mode is FULL 
indicating that all user accuracy settings have been satisfied.  Note, when using RTK the 
position threshold should be set to a smaller value i.e. 0.100m or whatever is specified in 
the survey parameters.  Exceeding any of the limits below will cause one of the radio 
lights to turn red and the POS mode will no longer report “Full Navigation” This however 
only affects the flag in the GGA or GGK message and not the performance.  
 
 

 
 
Port POSMV Final Navigation      
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Port side antenna and IMU mounting:  
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Vessel Name Ferdinand R. Hassler 
Year Built 2010 
POSMV Location STRB Side 
PCS Serial Number 3189 

IMU Serial Number 
Top Hat 

 
803 (Cable S/N 104) 

Hardware Version 3.3-7 

Firmware Version 5.03 

POS IP Address 
Subnet Mask 

129.100.1.231 
255.255.0.0 

POS PC Address 
Subnet Mask 

129.100.1.234 
255.255.255.0 

Survey Software Hypack 11.0.8.0 
Multibeam System Reson 7125 

 
Port System Lever Arms: (Units are in Meters) 
Point X Axis Y Axis Z Axis Notes 
Reference point 0.0 0.0 0.0 STRB IMU 
Ref to IMU 0.0 0.0 0.0 STRB IMU 
Ref to Primary GPS 1.929 -11.199 -13.084 Port FWD antenna 
Ref to Secondary GPS 1.953 -3.056 -13.083 Strb FWD antenna  
Ref to AUX GPS N/A N/A N/A Not surveyed 
Ref to Vessel 0.0 0.0 0.0 POS NMEA, message point 

of validity at target on IMU. 
IMU frame w.r.t Ref 
frame 

0.0 0.0 0.0 Rotation of IMU frame in 
comparison to ships frame.  

Ref to Heave (COR) 0.0 0.0 0.0 Center of gravity (rotation) 
Information not available.  

Ref to Sensor 1 0.0 0.0 0.0 Point of validity of HPR 
+Posn-Valid at IMU 

Ref to Sensor 2 0.0 0.0 0.0 Point of validity-HPR +Posn-
Valid at IMU 
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STRB POSMV 
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POSRT Data Extraction Utility [Jun 15 2011] 
Copyright (c) 2008-2011 Applanix Corporation.  All rights reserved. 
Date : 07/25/11    Time : 15:12:36 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
First POS file      : E:\Clients config, IP, & test results\Swath 250 Testing\Final 
Report Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.000 
Last POS file       : E:\Clients config, IP, & test results\Swath 250 Testing\Final 
Report Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.003 
Output path         : C:\Documents and Settings\bfrancis\My Documents\POSPac 
MMS\Unnamed(2)\Mission 1\Extract 
Output kernel       : Mission 1 
Start time          : 0.000 
End time            : 999999.000 
VNAV output modulus : 1 
-------------------------------------------------------------------------------- 
Opening file: E:\Clients config, IP, & test results\Swath 250 Testing\Final Report 
Files\Final_Data_IMUcorrect\For Bruce Frances\2011_152_S250_Stbd_GAMS.000 
307625.639 : Output time 1 is in UTC time 
307625.639 : Output time 2 is in POS time 
307625.639 : Output distances are in POS distance 
307625.639 : IMU type: IMU2  Data rate = 200 Hz 
307625.639 : Extracting Group 4 : Time-tag data 
307625.649 : SNV status changed to 0  (Full Nav) 
307626.069 : Primary GPS receiver type is GPS13. 
307626.094 : Secondary GPS receiver type is GPS13. 
307626.144 : Extracting Group 10: The General Status & FDIR data. 
307626.144 : GenA( 2):  IIN quadrant resolved SET. 
307626.144 : GenA( 3):  IIN fine align active SET. 
307626.144 : GenA( 4):  IIN navigator initialized SET. 
307626.144 : GenA( 5):  IIN navigator alignment active SET. 
307626.144 : GenA( 7):  IIN full navigation solution SET. 
307626.144 : GenA( 8):  IIN initial position valid SET. 
307626.144 : GenA(16):  RAM config != NVM SET. 
307626.144 : GenB( 0):  IIN user attitude performance SET. 
307626.144 : GenB( 1):  IIN user heading performance SET. 
307626.144 : GenB( 2):  IIN user position performance SET. 
307626.144 : GenB( 3):  IIN user velocity performance SET. 
307626.144 : GenB( 8):  GAMS installation parameters valid SET. 
307626.144 : GenB( 9):  GAMS solution in use SET. 
307626.144 : GenB(10):  GAMS solution OK SET. 
307626.144 : GenB(16):  Primary GPS configuration file sent SET. 
307626.144 : GenB(18):  Primary GPS in CA mode SET. 
307626.144 : GenB(23):  Primary GPS observables in use SET. 
307626.144 : GenB(24):  GAMS secondary GPS observables in use SET. 
307626.144 : GenC( 6):  RTCM Type 1 or 9 in use SET. 
307626.144 : GenC(13):  IIN in RTCM DGPS aided mode SET. 
307626.144 : FDIR1(13): Ephemeris missing SET. 
-------------------------------------------------------------------------------- 
307626.144 : The First Group 99: Versions & Statistics 
   System Version: 
     Product-Model: MV-320; Version: VER4; Serial Number: S/N3189; 
     Hardware Version: HW3.3-7; 
     Software Release Version-Date: SW05.03-Mar10/10; 
     ICD release version: ICD04.02; 
     Operating System Version: OS425B14; 
     IMU Type: IMU2; Primary GPS Type: PGPS13; Secondary GPS Type: SGPS13; 
     Option mnemonic-Expiry Time: DMI0; 
     Option mnemonic-Expiry Time: GIM0; 
     Option mnemonic-Expiry Time: RTK-0; 
     Option mnemonic-Expiry Time: THV-0; 
     Option mnemonic-Expiry Time: DPW-0; 
   Primary GPS Version: BD950    SN:4808A98939, v.00232, channels:24; 
   Secondary GPS Version: BD950  SN:4642A73565, v.00232, channels:24; 
   Total Hours          :    789.9; Number of Runs:     66 
   Average Length of Run:   12.0; Longest Run:   84.0; Current Run:   12.2; 
-------------------------------------------------------------------------------- 
307626.144 : Diffcorr2 time1 gap: start 0.0, end 307626.1439 
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-------------------------------------------------------------------------------- 
307633.139 : Message 50: Transition to NAVIGATE mode. 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 37: Base 1 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: NAD83  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 38: Base 2 setup 
   Input data type expected: RTCM 1 or 9  
   Datum Type: WGS84  
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 20: General parameters 
   Time and distance tag types:          2  1 
   Autostart selection:                   ENABLED 
   Reference-IMU lever arm:              -0.008  -0.031  0.130 
   Reference-primary GPS lever arm:      1.929  -11.199  -13.076 
   Reference-auxiliary 1 GPS lever arm:  0.000  0.000  0.000 
   Reference-auxiliary 2 GPS lever arm:  0.000  0.000  0.000 
   Reference-IMU mounting angles:        0.000  0.000  0.000 
   Reference-vehicle mounting angles:    0.000  0.000  0.000 
   Multipath environment:                 LOW 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 24: User accuracy parameters 
   User position accuracy:       2.00 
   User velocity accuracy:       0.50 
   User attitude accuracy:       0.05 
   User heading accuracy:        0.05 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 106: Heave ratios 
   Heave Bandwidth (sec):  12.000 
   Heave Damping Ratio:  0.707 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 120: Heave and sensor 1&2 install parameters 
   Reference-Sensor1 alignment angles (R,P,Y) in degrees:  0.000  0.000  0.000 
   Reference-Sensor2 alignment angles (R,P,Y) in degrees:  0.000  0.000  0.000 
   Reference-Sensor1 lever arm in meters:                  0.000  0.000  0.000 
   Reference-Sensor2 lever arm in meters:                  0.000  0.000  0.000 
   Reference-Centre of Rotation in meters:                 0.000  0.000  0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 121: Vessel Installation Parameters 
   Reference-Vessel in meters:                             0.00  0.00  0.00 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 32: PCS IP address 
   IP Address (Network part 1): 129 
   IP Address (Network part 2): 100 
   IP Address (Host part 1):    1 
   IP Address (Host part 2):    231 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 56: General data 
   Initial status:     COARSE_LEVEL 
   Initial position:   30.339738973 -88.576114608 -17.526 
   Initial distance:   0.00 
   Initial attitude:   0.000 0.000 0.000 
-------------------------------------------------------------------------------- 
-------------------------------------------------------------------------------- 
307633.139 : Message 21: GAMS install parameters 
   A-B antenna separation:        8.122 
   A-B baseline vector:           0.170 8.120 -0.003 
   Heading error for calibration: 0.50 
   A-B azimuth correction:        0.000 
-------------------------------------------------------------------------------- 
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Observed GAMS values derived from the field calibration: 
STRB GAMS Cal #1 
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Primary GPS data observed from internal Trimble BD950 receivers. 

 
 
Secondary embedded GPS data: 
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Com port #1 settings as installed: DGPS input from Trimble SPS Receiver. 

 
 
Com port #2 settings as installed 

 
 
Com port #3 settings as installed:  
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Com port #4 settings as installed:  
 

 
 
 
 
Com port #5 settings as installed 
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STRB POSMV Final Navigation 
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STRB side antenna and IMU mounting:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
STRB IMU Mount 

 







Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Ferdinand R. Hassler Vessel: S250

Date: 6/26/2013 Dn: 177

Personnel: Adler, Reed, Mortimer, Moehl

PCS Serial # IMU Serial #

IP Address: 129.100.1.232

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:

Approximate Position: Lat

Lon

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 289kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

Secondary GPS

3187

Driver, VA MBX-4

804

NOAA POS/MV Calibration Report

East of Cape Charles

Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.741 (Use View> GAMS Solution)

3.352

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration

Baseline Vector

Two Antenna Separation (m) X Component (m)

Heading Calibration Threshold YComponent (m)

Heading Correction Z Component (m)

Configuration Notes:

N



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time:

End time:

Heading accuracy achieved for calibration:

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values

Baseline Vector

Two Antenna Separation (m) X Component (m)

Heading Calibration Threshold YComponent (m)

Heading Correction Z Component (m)

GAMS Status Online

Save Settings

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

General Notes:General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC
$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select

None

COM3

Baud Rate Rate Parity Data Stop

Output Select

None

Input Select Input

? Input Type

Line



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Heave Bandwidth
Damping Ratio

Events (Use Settings > Events)

1
Positive, Negative Edge Trigger

2

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Reference to IMU IMU Frame w.r.t Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Primary GPS Lever Arm Reference to Primary Vessel Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Centre of Rotation Lever Arm
X (m)

Reference frame and vessel frame are co-aligned Y (m)
Z (m)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Time Tag 1 Multi Path
POS Time Low
GPS Time MediumGPS Time Medium
UTC Time High

Time Tag 2 Auto Start
POS Time Disabled
GPS Time Enabled
UTC Time
User Time

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Reference to Aux. 1 GPS Lever Arm Reference to Aux. 2 GPS Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Sensor 1 Lever Arm Sensor 1 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Sensor 2 Lever Arm Sensor 2 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

RMS Accuracy
Attitude (deg)
Heading (deg)
Position (m)
Velocity (m/s)



Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



The GAMS calibration was run on the fly before acquisition began with the new POS‐MV V5’s.  Due to 
the on‐the‐fly nature; the usual HSRR form was not completely filled out.  However, all relevant 
information was recorded by the watch stander at the time of acquisition. 

Date: 7/30/2013  Dn: 211 

Personnel: Adler, Moehl, Kist 

Location: Approaches to Chesapeake, outside south channel 

PDOP = 1.6  Heading accuracy achieved: 0.245 

All other settings were set up as before on the POS‐MV V4. 



Fill out all fields! See previous years as an example. Yellow areas require screen grabs!

Ship: Ferdinand R. Hassler Vessel: S250

Date: 6/26/2013 Dn: 177

Personnel: Adler, Reed, Mortimer, Moehl

PCS Serial # IMU Serial #

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 5.1.0.2

POS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver Serial #:

Secondary Receiver Serial #:

Calibration area
Location:

Approximate Position: Lat

Lon

DGPS Beacon Station: DGPS Receiver Serial#:

Frequency: 289kHz

Satellite Constellation (Use View> GPS Data)

Primary GPS
Insert screen grabs Note any differences from Primary GPS Receiver

Secondary GPS

3189

Driver, VA MBX-4

803

NOAA POS/MV Calibration Report

East of Cape Charles

Insert screen grabs Note any differences from Primary GPS Receiver

N
HDOP HDOP

VDOP VDOP

Sattelites in use: Sattelites in use:
L1 SNR > 30 35 40 L1 SNR > 30 35 40

PDOP 1.457 (Use View> GAMS Solution)

POS/MV Configuration
Settings

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration

Baseline Vector

Two Antenna Separation (m) X Component (m)

Heading Calibration Threshold YComponent (m)

Heading Correction Z Component (m)

Configuration Notes:

N



POS/MV Calibration

Calibration Procedure: (Refer to POS MV V4 Installation and Operation Guide, 4-25)

Start time: 1938.3

End time:

Heading accuracy achieved for calibration: 0.22

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values

Baseline Vector

Two Antenna Separation (m) X Component (m)

Heading Calibration Threshold YComponent (m)

Heading Correction Z Component (m)

GAMS Status Online

Save Settings

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name:

General Notes:General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System

The right-hand orthogonal system defines the following:

• The x-axis is in the fore-aft direction in the appropriate reference frame.

• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.

• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:

a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.

b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS

Input/Output Ports (Use Settings > Input/Output Ports)

COM1

Baud Rate Rate Parity Data Stop

Output Select NMEA Output

NMEA Roll Positive Sense

Pitch Positive Sense

Update Rate Heave Positive Sense

Input Select Taker ID

None

NMEA Output (selected strings shown here)
$INVTG $PASHR TB $INZDA
$INGST $PASHR TSS $INGGK
$INGGA $PRDID TB $UTC
$INHDT $PRDID TSS

COM2

Baud Rate Rate Parity Data Stop

Output Select Binary Output

Binary Roll Positive Sense

Update Rate Pitch Positive Sense

Formula Select Heave Positive Sense

Input Select

None

COM3

Baud Rate Rate Parity Data Stop

Output Select

None

Input Select Input

? Input Type

Line



SETTINGS Continued
Heave Filter (Use Settings > Heave)

Heave Bandwidth
Damping Ratio

Events (Use Settings > Events)

1
Positive, Negative Edge Trigger

2

INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Reference to IMU IMU Frame w.r.t Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Primary GPS Lever Arm Reference to Primary Vessel Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Centre of Rotation Lever Arm
X (m)

Reference frame and vessel frame are co-aligned Y (m)
Z (m)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Time Tag 1 Multi Path
POS Time Low
GPS Time MediumGPS Time Medium
UTC Time High

Time Tag 2 Auto Start
POS Time Disabled
GPS Time Enabled
UTC Time
User Time

Sensor Mounting (Use Settings > Installation > Sensor Mounting)

Reference to Aux. 1 GPS Lever Arm Reference to Aux. 2 GPS Lever Arm
X (m) X (m)
Y (m) Y (m)
Z (m) Z (m)

Reference to Sensor 1 Lever Arm Sensor 1 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

Reference to Sensor 2 Lever Arm Sensor 2 Frame w.r.t. Reference Frame
X (m) X (deg)
Y (m) Y (deg)
Z (m) Z (deg)

User Parameter Accuracy (Use Settings > Installation > User Accuracy)

RMS Accuracy
Attitude (deg)
Heading (deg)
Position (m)
Velocity (m/s)



Frame Control (Use Tools > Config)

User Frame Primary GPS Measurement
IMU Frame Auxiliary GPS Measurement

Use GAMS enabled



GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

Primary GPS  Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled

Secondary GPS Receiver

Baud Rate Parity Data Stop

Auto Configuration
Enabled
Disabled



The GAMS calibration was run on the fly before acquisition began with the new POS‐MV V5’s.  Due to 
the on‐the‐fly nature; the usual HSRR form was not completely filled out.  However, all relevant 
information was recorded by the watch stander at the time of acquisition. 

Date: 7/30/2013  Dn: 211 

Personnel: Adler, Moehl, Kist 

Location: Approaches to Chesapeake, outside south channel 

PDOP = 1.6  Heading accuracy achieved: 0.245 

All other settings were set up as before on the POS‐MV V4. 



Appendix IV 
 
 
Sound Speed Sensor Reports 
 



 

AML Oceanographic 
2071 Malaview Avenue, Sidney B.C.   V8L 5X6   CANADA 

T: +1-250-656-0771   F: +1-250-655-3655   Email: service@AMLoceanographic.com 

Certificate of Conformity 

  

Customer:    

AML Reference Number:  

Customer PO Number:   

Asset Serial Number:   

Asset Product Type:    

Housing Depth Rating:  

Additional Description:   

 

 

Certification Date (dd/mm/yyyy):   

Certified By: 

 

Robert Haydock 
President 

AML Oceanographic 
 

AML Oceanographic certifies that the equipment described above has been tested in accordance with the 
product’s technical specifications, brochures and / or relevant drawings.  Housing depth rating refers to the 
maximum deployment depth of this instrument; on-board sensors may further restrict this range.  AML 
Oceanographic certifies that calibrations on this instrument have been completed with equipment referenced to 
traceable standards. 

Instrument configuration files and soft copy certificates are available at our on-line Customer Centre at 
www.AMLoceanographic.com/support 

NOAA - Marine Operations Center Atlantic

Sales Order #32448

EE1338M13SU0888

008609

Micro CTD, Titanium, MVP, with Extended Temp & Cond Range

1000 dbar / meters

5/9/2013



AML Oceanographic

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA

T: +1 250 656 0771 F: +1 250 655 3655 Email: service@AMLoceanographic.com

Certificate of Calibration

Customer:

Asset Serial Number:

Asset Product Type:

Calibration Type:

Calibration Range:

Calibration RMS Error:

Calibration ID:

Installed On:

Coefficient A:

Coefficient B:

Coefficient C:

Coefficient D:

Coefficient E:

Coefficient F:

Coefficient G:

Coefficient H:

Coefficient I:

Coefficient J:

Coefficient K:

Coefficient L:

Coefficient M:

Coefficient N:

Calibration Date (dd/mm/yyyy):

Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to

traceable standards. Please note that Xchange
TM sensor heads may be installed on assets other than the one listed above; this

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,

please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post

processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

NOAA - Marine Operations Center Atlantic

008609

Micro CTD, Titanium, MVP, with Extended Temp & Cond Range

Temperature

-2 to +45 Deg C

.0006

008609 006895 400672 040913 130959

-5.513578E-28

0.000000E+0

0.000000E+0

4/9/2013

0.000000E+0

0.000000E+0

0.000000E+0

0.000000E+0

0.000000E+0

1.684108E-3

-1.616296E+1

-3.748911E-8

9.902842E-13

-1.609277E-17

1.519287E-22



AML Oceanographic

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA

T: +1 250 656 0771 F: +1 250 655 3655 Email: service@AMLoceanographic.com

Certificate of Calibration

Customer:

Asset Serial Number:

Asset Product Type:

Calibration Type:

Calibration Range:

Calibration RMS Error:

Calibration ID:

Installed On:

Coefficient A:

Coefficient B:

Coefficient C:

Coefficient D:

Coefficient E:

Coefficient F:

Coefficient G:

Coefficient H:

Coefficient I:

Coefficient J:

Coefficient K:

Coefficient L:

Coefficient M:

Coefficient N:

Calibration Date (dd/mm/yyyy):

Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to

traceable standards. Please note that Xchange
TM sensor heads may be installed on assets other than the one listed above; this

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,

please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post

processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

NOAA - Marine Operations Center Atlantic

008609

Micro CTD, Titanium, MVP, with Extended Temp & Cond Range

Pressure

1000dbar

.0402

008609 005117 008610 280813 113307

0.000000E+0

-3.129018E-14

0.000000E+0

28/8/2013

0.000000E+0

2.299408E-9

0.000000E+0

0.000000E+0

0.000000E+0

0.000000E+0

-1.231444E+2

0.000000E+0

0.000000E+0

1.899598E-2

0.000000E+0



AML Oceanographic

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA

T: +1 250 656 0771 F: +1 250 655 3655 Email: service@AMLoceanographic.com

Certificate of Calibration

Customer:

Asset Serial Number:

Asset Product Type:

Calibration Type:

Calibration Range:

Calibration RMS Error:

Calibration ID:

Installed On:

Coefficient A:

Coefficient B:

Coefficient C:

Coefficient D:

Coefficient E:

Coefficient F:

Coefficient G:

Coefficient H:

Coefficient I:

Coefficient J:

Coefficient K:

Coefficient L:

Coefficient M:

Coefficient N:

Calibration Date (dd/mm/yyyy):

Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to

traceable standards. Please note that Xchange
TM sensor heads may be installed on assets other than the one listed above; this

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,

please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post

processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

NOAA - Marine Operations Center Atlantic

008609

Micro CTD, Titanium, MVP, with Extended Temp & Cond Range

Conductivity

0 to 79 mS/cm

.0024

008609 006895 500349 040913 130959

1.359085E-11

0.000000E+0

0.000000E+0

4/9/2013

-3.388081E-14

0.000000E+0

0.000000E+0

0.000000E+0

0.000000E+0

5.996294E-7

-9.799962E-3

-4.226755E-9

1.053693E-11

3.151113E-5

-1.928069E-9



 

AML Oceanographic 
2071 Malaview Avenue, Sidney B.C.   V8L 5X6   CANADA 

T: +1-250-656-0771   F: +1-250-655-3655   Email: service@AMLoceanographic.com 

Certificate of Conformity 

  

Customer:    

AML Reference Number:  

Customer PO Number:   

Asset Serial Number:   

Asset Product Type:    

Housing Depth Rating:  

Additional Description:   

 

 

Certification Date (dd/mm/yyyy):   

Certified By: 

 

Robert Haydock 
President 

AML Oceanographic 
 

AML Oceanographic certifies that the equipment described above has been tested in accordance with the 
product’s technical specifications, brochures and / or relevant drawings.  Housing depth rating refers to the 
maximum deployment depth of this instrument; on-board sensors may further restrict this range.  AML 
Oceanographic certifies that calibrations on this instrument have been completed with equipment referenced to 
traceable standards. 

Instrument configuration files and soft copy certificates are available at our on-line Customer Centre at 
www.AMLoceanographic.com/support 

NOAA - Marine Operations Center Atlantic

Sales Order #32448

EE1338M13SU0888

008610

Micro CTD, Titanium, MVP, with Extended Temp & Cond Range

1000 dbar / meters

5/9/2013



AML Oceanographic

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA

T: +1 250 656 0771 F: +1 250 655 3655 Email: service@AMLoceanographic.com

Certificate of Calibration

Customer:

Asset Serial Number:

Asset Product Type:

Calibration Type:

Calibration Range:

Calibration RMS Error:

Calibration ID:

Installed On:

Coefficient A:

Coefficient B:

Coefficient C:

Coefficient D:

Coefficient E:

Coefficient F:

Coefficient G:

Coefficient H:

Coefficient I:

Coefficient J:

Coefficient K:

Coefficient L:

Coefficient M:

Coefficient N:

Calibration Date (dd/mm/yyyy):

Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to

traceable standards. Please note that Xchange
TM sensor heads may be installed on assets other than the one listed above; this

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,

please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post

processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

NOAA - Marine Operations Center Atlantic

008610

Micro CTD, Titanium, MVP, with Extended Temp & Cond Range

Temperature

-2 to +45 Deg C

.0012

008610 006891 400000 040913 130945

008610

-2.737331E-28

0.000000E+0

0.000000E+0

4/9/2013

0.000000E+0

0.000000E+0

0.000000E+0

0.000000E+0

0.000000E+0

1.641995E-3

-1.602931E+1

-3.434131E-8

8.412781E-13

-1.220503E-17

9.987001E-23



AML Oceanographic

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA

T: +1 250 656 0771 F: +1 250 655 3655 Email: service@AMLoceanographic.com

Certificate of Calibration

Customer:

Asset Serial Number:

Asset Product Type:

Calibration Type:

Calibration Range:

Calibration RMS Error:

Calibration ID:

Installed On:

Coefficient A:

Coefficient B:

Coefficient C:

Coefficient D:

Coefficient E:

Coefficient F:

Coefficient G:

Coefficient H:

Coefficient I:

Coefficient J:

Coefficient K:

Coefficient L:

Coefficient M:

Coefficient N:

Calibration Date (dd/mm/yyyy):

Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to

traceable standards. Please note that Xchange
TM sensor heads may be installed on assets other than the one listed above; this

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,

please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post

processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

NOAA - Marine Operations Center Atlantic

008610

Micro CTD, Titanium, MVP, with Extended Temp & Cond Range

Pressure

1000 dBar

.0737

008610 005117 008610 280813 113343

008610

0.000000E+0

1.790184E-14

0.000000E+0

28/8/2013

0.000000E+0

-3.600100E-9

0.000000E+0

0.000000E+0

0.000000E+0

0.000000E+0

-1.255179E+2

0.000000E+0

0.000000E+0

1.919673E-2

0.000000E+0



AML Oceanographic

2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA

T: +1 250 656 0771 F: +1 250 655 3655 Email: service@AMLoceanographic.com

Certificate of Calibration

Customer:

Asset Serial Number:

Asset Product Type:

Calibration Type:

Calibration Range:

Calibration RMS Error:

Calibration ID:

Installed On:

Coefficient A:

Coefficient B:

Coefficient C:

Coefficient D:

Coefficient E:

Coefficient F:

Coefficient G:

Coefficient H:

Coefficient I:

Coefficient J:

Coefficient K:

Coefficient L:

Coefficient M:

Coefficient N:

Calibration Date (dd/mm/yyyy):

Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to

traceable standards. Please note that Xchange
TM sensor heads may be installed on assets other than the one listed above; this

calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,

please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post

processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

NOAA - Marine Operations Center Atlantic

008610

Micro CTD, Titanium, MVP, with Extended Temp & Cond Range

Conductivity

0 to 79 mS/cm

.0034

008610 006891 500346 040913 130945

008610

4.956807E-12

0.000000E+0

0.000000E+0

4/9/2013

-6.139943E-15

0.000000E+0

0.000000E+0

0.000000E+0

0.000000E+0

3.672003E-7

-9.621067E-3

-1.561394E-9

1.934082E-12

3.054307E-5

-1.165715E-9



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 19Plus

Date of Report: 2/21/2013

Serial Number: 19P32914-4480

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/21/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00010 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4480

CALIBRATION DATE: 21-Feb-13

SBE19plus CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.840920e-001

h =  1.354693e-001

i = -2.445297e-004

j =  3.737361e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2699.11     0.0000      0.00000

   1.0000    34.9500    2.98630    5418.29     2.9863      0.00000

   4.5000    34.9237    3.29386    5623.54     3.2939     -0.00000

  15.0000    34.8770    4.27827    6234.39     4.2783      0.00000

  18.5000    34.8674    4.62441    6435.10     4.6244     -0.00000

  24.0000    34.8569    5.18400    6746.63     5.1840      0.00000

  29.0000    34.8509    5.70735    7025.12     5.7073     -0.00000

  32.4999    34.8470    6.08073    7217.03     6.0807      0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4480

CALIBRATION DATE: 20-Feb-13

SBE19plus PRESSURE CALIBRATION DATA

 5076 psia S/N 3336

 

COEFFICIENTS:

PA0 =    1.128466e+000

PA1 =    1.569411e-002

PA2 =   -6.760475e-010

PTEMPA0 = -6.692981e+001

PTEMPA1 =  5.114088e+001

PTEMPA2 = -4.158643e-001

PTCA0 =  5.242175e+005

PTCA1 =  1.632429e+000

PTCA2 =  8.402568e-002

PTCB0 =  2.508287e+001

PTCB1 = -2.500000e-005

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.62 525154.0   1.7       14.70   0.00         32.50     1.98   525242.95

 1026.89 589823.4   1.7     1026.73  -0.00         29.00     1.91   525217.54

 2039.27 654881.4   1.8     2039.15  -0.00         24.00     1.80   525186.78

 3051.44 720307.0   1.8     3051.52   0.00         18.50     1.69   525159.19

 4063.30 786079.0   1.8     4063.41   0.00         15.00     1.62   525144.39

 5075.05 852207.2   1.8     5074.89  -0.00          4.50     1.41   525110.03

 4063.27 786078.2   1.8     4063.40   0.00          1.00     1.34   525101.18

 3051.05 720281.5   1.8     3051.12   0.00

 2038.97 654864.8   1.8     2038.88  -0.00         TEMP(ITS90)   SPAN(mV)

 1026.65 589818.8   1.8     1026.65   0.00            -5.00       25.08

   14.62 525154.7   1.8       14.69   0.00            35.00       25.08

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4480

CALIBRATION DATE: 21-Feb-13

SBE19plus TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.261198e-003

a1 =  2.596548e-004

a2 =  3.906321e-007

a3 =  1.341833e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            619145.322             0.9999             -0.0001

   4.5000            549771.339             4.5001              0.0001

  15.0000            377667.831            14.9998             -0.0002

  18.5000            331463.542            18.5001              0.0001

  24.0000            268745.983            24.0002              0.0002

  29.0000            221011.136            28.9999             -0.0001

  32.4999            192176.373            32.4999              0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 19Plus

Date of Report: 2/21/2013

Serial Number: 19P32914-4480

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/21/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00021 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 19Plus

Date of Report: 2/21/2013

Serial Number: 19P36399-4642

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/21/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: 0.0000 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4642

CALIBRATION DATE: 21-Feb-13

SBE19plus CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -1.027504e+000

h =  1.276730e-001

i = -1.844672e-004

j =  2.917455e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2840.10     0.0000      0.00000

   1.0000    34.9500    2.98630    5609.55     2.9863      0.00000

   4.5000    34.9237    3.29386    5819.80     3.2939     -0.00000

  15.0000    34.8770    4.27827    6446.05     4.2783     -0.00000

  18.5000    34.8674    4.62441    6651.97     4.6244     -0.00000

  24.0000    34.8569    5.18400    6971.70     5.1840      0.00001

  29.0000    34.8509    5.70735    7257.64     5.7073     -0.00000

  32.4999    34.8470    6.08073    7454.74     6.0807     -0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4642

CALIBRATION DATE: 12-Feb-13

SBE19plus PRESSURE CALIBRATION DATA

  508 psia S/N 5632

 

COEFFICIENTS:

PA0 =    6.361379e-001

PA1 =    1.547553e-003

PA2 =    7.068208e-012

PTEMPA0 = -7.494654e+001

PTEMPA1 =  4.812371e+001

PTEMPA2 = -1.644541e-001

PTCA0 =  5.323160e+005

PTCA1 =  2.214437e+001

PTCA2 = -1.515019e-001

PTCB0 =  2.569025e+001

PTCB1 = -3.500000e-004

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.62 541760.0   2.0       14.62   0.00         32.50     2.25   542119.97

  104.92 600055.0   2.0      104.89  -0.01         29.00     2.18   542074.14

  204.94 664596.0   2.0      204.89  -0.01         24.00     2.07   542003.21

  304.93 729105.0   2.0      304.90  -0.01         18.50     1.96   541917.24

  404.94 793584.0   2.0      404.92  -0.00         15.00     1.88   541857.86

  504.95 858013.0   2.0      504.93  -0.00          4.50     1.66   541658.25

  404.93 793610.0   2.0      404.97   0.01          1.00     1.59   541580.16

  304.91 729137.0   2.0      304.95   0.01

  204.93 664630.0   2.0      204.94   0.00         TEMP(ITS90)   SPAN(mV)

  104.92 600090.0   2.0      104.94   0.01            -5.00       25.69

   14.62 541765.0   2.0       14.62   0.00            35.00       25.68

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 4642

CALIBRATION DATE: 21-Feb-13

SBE19plus TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.189296e-003

a1 =  2.752200e-004

a2 = -1.004240e-006

a3 =  1.917300e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            625334.864             1.0000             -0.0000

   4.5000            556565.881             4.5000              0.0000

  15.0000            385279.797            14.9999             -0.0001

  18.5000            339088.017            18.5002              0.0002

  24.0000            276209.712            23.9999             -0.0001

  29.0000            228180.576            29.0001              0.0001

  32.4999            199092.797            32.4999             -0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 19Plus

Date of Report: 2/21/2013

Serial Number: 19P36399-4642

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/21/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00039 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 19Plus

Date of Report: 2/21/2013

Serial Number: 19P65591-6918

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/21/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00050 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6918

CALIBRATION DATE: 21-Feb-13

SBE19plusV2 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.857831e-001

h =  1.554019e-001

i = -3.372723e-004

j =  4.919322e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2522.99     0.0000      0.00000

   1.0000    34.9500    2.98630    5062.98     2.9863     -0.00000

   4.5000    34.9237    3.29386    5254.81     3.2939      0.00000

  15.0000    34.8770    4.27827    5825.77     4.2783     -0.00000

  18.5000    34.8674    4.62441    6013.40     4.6244     -0.00000

  24.0000    34.8569    5.18400    6304.64     5.1840      0.00001

  29.0000    34.8509    5.70735    6565.01     5.7073     -0.00001

  32.4999    34.8470    6.08073    6744.44     6.0807      0.00000

 

f = INST FREQ / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6918

CALIBRATION DATE: 20-Feb-13

SBE19plusV2 PRESSURE CALIBRATION DATA

  508 psia S/N 3313900

 

COEFFICIENTS:

PA0 =    9.896364e-002

PA1 =    1.548011e-003

PA2 =    6.074867e-012

PTEMPA0 = -5.589951e+001

PTEMPA1 =  5.523046e+001

PTEMPA2 = -6.499467e-001

PTCA0 =  5.244489e+005

PTCA1 =  4.872239e+000

PTCA2 = -1.058173e-001

PTCB0 =  2.490900e+001

PTCB1 = -1.400000e-003

PTCB2 =  0.000000e+000

 

  PRESSURE SPAN CALIBRATION                                                               THERMAL CORRECTION

  PRESSURE      INST   THERMISTOR  COMPUTED  ERROR                    TEMP  THERMISTOR      INST

         PSIA      OUTPUT    OUTPUT        PRESSURE      %FSR                      ITS90       OUTPUT       OUTPUT

   14.69 533902.0   1.4       14.66  -0.01         32.50     1.63   534126.92

  104.96 592150.0   1.4      104.97   0.00         29.00     1.57   534133.29

  204.98 656614.0   1.4      204.96  -0.00         24.00     1.47   534137.48

  304.99 721057.0   1.4      304.97  -0.00         18.50     1.37   534134.87

  405.01 785472.0   1.4      404.99  -0.00         15.00     1.30   534129.58

  505.00 849842.0   1.4      504.99  -0.00          4.50     1.11   534099.87

  404.98 785484.0   1.4      405.01   0.01          1.00     1.04   534086.20

  304.98 721079.0   1.4      305.01   0.01

  205.00 656634.0   1.4      205.00  -0.00         TEMP(ITS90)   SPAN(mV)

  105.00 592156.0   1.4      104.98  -0.00            -5.00       24.92

   14.62 533897.0   1.4       14.66   0.01            35.00       24.86

 

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2

Date, Avg Delta P %FS
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 6918

CALIBRATION DATE: 21-Feb-13

SBE19plusV2 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  1.287679e-003

a1 =  2.705728e-004

a2 = -1.142888e-006

a3 =  1.804726e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                             OUTPUT(n)                                    (ITS-90)                                  (ITS-90)

   1.0000            563939.441             1.0000              0.0000

   4.5000            497022.831             4.5000             -0.0000

  15.0000            333856.390            15.0000              0.0000

  18.5000            290801.644            18.5000             -0.0000

  24.0000            232902.322            24.0000             -0.0000

  29.0000            189281.017            29.0000              0.0000

  32.4999            163135.119            32.4999             -0.0000

 

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 19Plus

Date of Report: 2/21/2013

Serial Number: 19P65591-6918

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/21/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: +0.00008 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 45

Date of Report: 2/28/2013

Serial Number: 4553332-0276

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/28/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00170 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 0276

CALIBRATION DATE: 28-Feb-13

SBE 45 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -1.001879e+000

h =  1.571774e-001

i = -2.802980e-004

j =  4.780569e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

WBOTC =  4.2855e-007

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2527.95    0.00000      0.00000

   1.0000    34.8154    2.97590    5033.86    2.97589     -0.00000

   4.5001    34.7933    3.28278    5223.80    3.28279      0.00001

  15.0000    34.7509    4.26444    5788.86    4.26442     -0.00002

  18.5000    34.7420    4.60958    5974.58    4.60956     -0.00001

  24.0000    34.7323    5.16751    6262.87    5.16753      0.00001

  28.9997    34.7264    5.68922    6520.58    5.68924      0.00002

  32.5001    34.7243    6.06177    6698.33    6.06175     -0.00002

 

f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 0276

CALIBRATION DATE: 28-Feb-13

SBE 45 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  7.319125e-005

a1 =  2.662731e-004

a2 = -1.861429e-006

a3 =  1.352567e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                                OUTPUT                                    (ITS-90)                                  (ITS-90)

   1.0000             695550.9             1.0000              0.0000

   4.5001             593258.4             4.5000             -0.0001

  15.0000             375473.6            14.9999             -0.0001

  18.5000             324399.0            18.5001              0.0001

  24.0000             259362.0            24.0002              0.0002

  28.9997             212936.3            28.9992             -0.0005

  32.5001             186084.7            32.5004              0.0003

 

Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln
2

(n)] + a3[ln
3

(n)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 45

Date of Report: 2/28/2013

Serial Number: 4553332-0276

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/28/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00005 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 45

Date of Report: 2/28/2013

Serial Number: 4553332-0277

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/28/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00060 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 0277

CALIBRATION DATE: 28-Feb-13

SBE 45 CONDUCTIVITY CALIBRATION DATA

PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

 

COEFFICIENTS:

g = -9.782419e-001

h =  1.536406e-001

i = -3.557364e-004

j =  5.226581e-005

CPcor = -9.5700e-008

CTcor =  3.2500e-006

WBOTC =  4.2855e-007

 

 BATH TEMP       BATH SAL    BATH COND     INST FREQ       INST COND         RESIDUAL

       (ITS-90)             (PSU)           (Siemens/m)            (Hz)               (Siemens/m)         (Siemens/m)

  22.0000     0.0000    0.00000    2527.95    0.00000      0.00000

   1.0000    34.8154    2.97590    5080.68    2.97590      0.00000

   4.5001    34.7933    3.28278    5273.56    3.28278      0.00000

  15.0000    34.7509    4.26444    5847.17    4.26443     -0.00000

  18.5000    34.7420    4.60958    6035.61    4.60957     -0.00000

  24.0000    34.7323    5.16751    6328.06    5.16752      0.00001

  28.9997    34.7264    5.68922    6589.42    5.68921     -0.00000

 

f = INST FREQ * sqrt(1.0 + WBOTC * t) / 1000.0

Conductivity = (g + hf
2

 + if
3

 + jf
4

) / (1 + δt + εp) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; δ = CTcor; ε = CPcor;

Residual = instrument conductivity - bath conductivity

Date, Slope Correction
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

 

SENSOR SERIAL NUMBER: 0277

CALIBRATION DATE: 28-Feb-13

SBE 45 TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

 

ITS-90 COEFFICIENTS

a0 =  9.741662e-005

a1 =  2.657622e-004

a2 = -1.821791e-006

a3 =  1.353495e-007

 

 BATH TEMP                          INSTRUMENT                         INST TEMP                              RESIDUAL

       (ITS-90)                                OUTPUT                                    (ITS-90)                                  (ITS-90)

   1.0000             638629.1             1.0001              0.0001

   4.5001             544707.0             4.4999             -0.0002

  15.0000             344732.6            15.0000             -0.0000

  18.5000             297836.4            18.5001              0.0001

  24.0000             238119.1            24.0003              0.0003

  28.9997             195493.2            28.9990             -0.0007

  32.5001             170836.7            32.5004              0.0003

 

Temperature ITS-90 = 1/{a0 + a1[ln(n)] + a2[ln
2

(n)] + a3[ln
3

(n)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

Date, Delta T (mdeg C)
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Customer: Atlantic Marine Center

Job Number: 73178

Model Number SBE 45

Date of Report: 2/28/2013

Serial Number: 4553332-0277

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 2/28/2013 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00034 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  

If the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report
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